Notices

© Agilent Technologies, Inc. 2006-2010

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Edition

Third Edition, Jan. 2010
Printed in China
Agilent Technologies, Inc.
No. 116 Tuo Xin West 1st Street
Hi-Tech Industrial Zone (South)
Chengdu 611731, China

Software Revision

This guide is valid for A.02.00 revisions of the Agilent N9310A RF Signal Generator software.

Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend

U.S. Government Restricted Rights. Software and technical data rights granted to the federal government include only those rights customarily provided to end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation).

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
# Contents

1 Overview 1
   Agilent N9310A At a Glance 2
   Front Panel Overview 4
   Front Panel Display 7
   Rear Panel Overview 9
   Front and rear panel symbols 11

2 Getting Started 13
   Check the Shipment and Order List 14
   Safety Notice 17
   Environmental Requirements 18
   Electrical Requirements 19
   Power on and Check 22
      Turn On the Signal Generator 23
      Check for Error Messages 24
   Some Tips 25
      Enable an option 25
      Remote Control 26
      Firmware Update 27
   Connector Maintenance 28

3 Using Functions 29
   Commonly used Front-panel Elements 30
   Generating a CW Signal 31
AM State 132
AM Depth 133
AM Rate 133
AM Source 134
AM External Coupling 134

FM Subsystem 135
FM State 135
FM Deviation 136
FM Rate 136
FM Source 137
FM External Coupling 137

Phase Modulation Subsystem 138

Pulse Modulation Subsystem 140

I/Q Modulation Subsystem 142

Utility Subsystem 143
Display Style 143
Error Messages 143
Screen Saver 144
System Date 144
System Time 145
Reference Oscillator Sources 145
Phase Noise Mode 146

Modulation State Subsystem 147

RF Output State Subsystem 148

LF Output Subsystem 149

Subsystem Command Trees 151
Symbols used in Command Trees 151
Frequency Subsystem 152
Amplitude Subsystem 153
Trigger Subsystem 153
1 Overview

General Features and Functions  2
Options  3
Front Panel Overview  4
Front Panel Display  7
Rear Panel Overview  9
Front and rear panel symbols  11

This chapter describes the general features and functions of the Agilent N9310A RF Signal Generator and provides an introduction to the front and rear panel.
Agilent N9310A At a Glance

The Agilent N9310A is a general purpose RF signal generator with applications in manufacturing, service, research, development and education.

The signal generator has an optional broadband I/Q modulator, able to generate digital signals in conjunction with an external I/Q source.

General Features and Functions

The Agilent N9310A RF Signal Generator provides:

- 9 kHz to 3 GHz frequency range
- –127 to +13 dBm level range (settable to +20 dBm)
- Built in AM, FM, ΦM, and pulse modulation
- RF sweep, LF sweep and amplitude sweep
- LF output: 20 Hz to 80 kHz, 0-3 Vp (into 50 Ω)
- I/Q modulator (optional)
- 6.5-inch TFT LCD
- Universal USB interface
- 1-year calibration cycle
Options

This section provides an overview of available options. For details, please refer to http://www.agilent.com/find/n9310a.

- Option 001: I/Q modulator
  (part number: N9310A -001)
  This option provides an additional internal I/Q modulator. Using this option in the signal generator generates digital signals. Option 001 also requires an external I/Q baseband signal input.

- Option 1CM: Rackmount flange kit
  (part number: N9310A -1CM)
  Use the rack mount kit to facilitate installation in a standard rack system.

- Option 1TC: Hard transit case
  (part number: N9310A -1TC)
  A hard transit case protects the signal generator during transportation and storage.
Front Panel Overview

1 Display  The LCD screen shows information on the current function. Information includes status indicators, frequency and amplitude settings, and error messages. Function specific menu labels for the softkeys are shown on the right-hand side of the display. For further description of the front panel display, refer to “Front Panel Display” on page 7.

2 Softkeys  Softkey menus are determined by the Function chosen. The softkey menu selections are displayed to the left of each key and activate features and functions associated with the Function hardkeys. Refer to Chapter 4, “Key Reference,” starting on page 53 for further information.

3 Enter  The Enter hardkey terminates data entry field or parameter selection. Also functions as a single sweep trigger.

4 Amplitude  Press the Amplitude hardkey to edit the CW (continuous wave) power levels.

5 Frequency  Press the frequency hardkey to edit the CW frequency parameter.

6 Function keys  These hardkey selections directly access the following main instrument functions:
   • Preset  sets the signal generator to factory default settings.
• **AM** configures the amplitude modulation function.
• **FM** configures a frequency modulation function.
• **ΦM** configures a phase modulation function.
• **Pulse** configures a pulse modulation function.
• **I/Q** activates the I/Q modulation function.
• **Sweep** configures RF/LF/Amplitude sweep function.
• **Trigger** triggers an armed sweep.
• **Utility** sets the system configurations
• **Local** returns the control from remote to local.
• **File** saves, recalls or deletes customized configuration files.
• **LF Out** configures a low frequency signal.

7 **Mod On/Off** Press the **Mod On/Off** hardkey to toggle the modulator state between On and Off. A **MOD On/Off** annunciator is visible on the screen, indicating whether the modulator is enabled or not. A user must select the modulation type and select from the menu softkeys to turn modulation on (for example, **AM** > **AM On**), or no modulation will be applied to the output carrier signal, even though the modulator is enabled (**MOD On**).

8 **Knob** The front panel knob increases or decreases a value, a numeric digit, or scrolls up and down to select an item in a list.

9 **Arrow keys** The left and right arrow keys shift the selected digit in the active entry area of the display; Once an individual digit is selected, you can change its value by rotating the knob.

10 **RF On/Off** The **RF On/Off** hardkey toggles the RF output state between On and Off. A **RF On/Off** annunciator is always visible on the display, indicating whether the RF output is enabled or not.
11 **RF Out connector**  Female N-type connector provides the Signal Generator RF output signal. The impedance is 50 ohm. The damage level is +36 dBm maximum.

12 **LF Out connector**  BNC (F) connector outputs the low frequency (LF) signal whenever you set the > LF OUT to on. The LF output is capable of driving a 3Vpeak (nominal) signal into a 50 ohm load.

13 **Numeric Keypad**  0 through 9 numeric keys, decimal point and a backspace key. The backspace hardkey may be used to input a negative value. When entering a negative value, enter a negative sign prior to entering the numeric value.

14 **Standby Switch**  switching to the On position activates all functions of the signal generator. When pressing this key to switch the signal generator Off, the signal generator deactivate all the functions but still remains connected to the line power, while the line power is supplied to some internal circuits.

15 **Switch On LED**  This green LED lights when the signal generator is switched on using the front panel standby switch.

16 **Standby LED**  This orange LED lights when the line power is switched on with the rear panel power switch.

17 **Remote LED**  This LED lights when the signal generator is remotely controlled by a PC by way of the USB host interface located on the rear panel.

18 **USB Type A (Host) Connector**  provides a port connection for use by external USB devices, such as a USB memory stick.
Front Panel Display

1 **Frequency Area** displays the current CW (continuous wave) frequency.

2 **Amplitude Area** displays the current output power level.

3 **Annunciators** display the status of most of the signal generator functions, as well as indicating errors generated. An annunciator position may be used by more than one function.
   - $\Phi M$ becomes active when $\Phi M$ is enabled.
   - $\text{AM}$ becomes active when an AM is enabled.
   - $\text{ARMED}$ becomes active when a sweep mode is selected and the signal generator is waiting for a trigger to initiate sweeping.
   - $\text{ERR}$ becomes active when an error is generated. This annunciator will not turn off until you have viewed all the error messages and cleared the error queue. You can access error messages by pressing `Utility > Error Info`. 

![Diagram of Front Panel Display](image-url)
1 Overview

- **EXT REF** becomes active when an external frequency reference is applied.
- **FM** becomes active when an FM is enabled.
- **I/Q** becomes active when an I/Q modulation is enabled.
- **MOD ON/OFF** indicates when the RF carrier is modulated (MOD ON indicates the modulator is enabled, while MOD OFF indicates disabled). Either state is always visible on the screen.
- **PULSE** becomes active when a pulse modulation is enabled.
- **RF ON/OFF** indicates whether the RF output is enabled or disabled. RF status is always visible in the display.
- **Sweep** becomes active when the signal generator is sweeping.
- **UNCAL** becomes active when the signal generator is unable to maintain the correct level.
- **UNLOCK** becomes active when any of the phase locked loops are unable to maintain phase lock. To view further descriptions, please refer to Chapter 7, “Instrument Messages,” starting on page 173.

4 **Softkey Label** displays submenus of each function. The content of softkey labels change according to the function selected. Refer to Chapter 4, “Key Reference,” starting on page 53 for further information.

5 **Message Area** displays abbreviated system messages. When multiple system messages occur, only the most recent message is displayed. Press > Error Info to view all reported system messages along with details.

6 **Status Area** displays state information about the signal generator, such as the modulation status, sweep status, and file catalogs and storages.

7 **Active Function Area** displays the current active function. For example, if you press hardkey, the frequency is active and the current frequency setting is displayed.
Rear Panel Overview

1 **Power switch**  The power switch isolates the signal generator from the AC line power. After pressing this switch to the On position, the signal generator enters standby mode and the standby LED (orange) on the front panel indicates that line power is on.

2 **AC power receptacle**  The power receptacle accepts a standard three-conductor plug.

3 **USB Type B (Device) connector**  Used for connecting with a controller, such as a PC.

4 **TRIG IN connector**  BNC (F) connector, accepts a TTL signal for triggering a sweep. Triggering occurs on either the positive or negative edge. The frequency of the external trigger source may be no greater than 100 Hz. The damage level is $\geq +10 \text{ V}$ or $\leq -4 \text{ V}$.

5 **REF OUT connector**  BNC (F) connector for output of the internal reference frequency, which has a nominal output level greater than $0.35\text{Vrms}$, and an output impedance of 50 ohm.
6 **REF IN connector**  BNC (F) connector, accepts a -3.5 to +20 dBm signal from an external reference oscillator that is within ±1 ppm. The nominal input impedance is 50 ohm. The instrument will accept a 2MHz, 5MHz, or 10 MHz reference oscillator signal.

7 **PULSE MOD IN connector**  BNC (F) input connector accepts a TTL signal for pulse modulation. The damage level is 5 Vrms.

8 **MOD IN connector**  BNC (F) input connector accepts a 1.0 ± 2% V (peak) signal for AM, FM, and phase modulation. For all modulation types, a +1.0 Vpeak produces the indicated deviation or depth. The damage level is 5 Vrms.

9 **Q IN connector**  BNC (F) input connector accepts an external quadrature-phase component of an I/Q baseband signal. The signal level is $\sqrt{I^2 + Q^2} = 0.5$ Vrms for calibrated output level. The input impedance is 50 Ohm. The damage level is 1 Vrms.

10 **I IN connector**  BNC (F) input connector accepts an externally in-phase component of an I/Q modulation signal. It has the same characteristics as the Q baseband signal.

   **NOTE**  The I/Q IN connectors are only available for external I/Q signal input with Option 001.

11 **VGA connector**  outputs to an external monitor or projector.

12 **USB Type A (Host) connector**  connect with external USB devices, such as a USB memory stick.
Front and rear panel symbols

The signal generator uses the following symbols. Before operation, familiarize yourself with each marking and its meaning.

**The instruction manual symbol:** indicates that the user must refer to specific instructions in the manual.

**The CE mark:** a registered trademark of the European Community.

shows that this is an Industrial Scientific and Medical Group 1 Class A product. (CISPR 11, Clause 4)

**The CSA mark:** a registered trademark of the Canadian Standards Association International.

The ISM device complies with Canadian Interference-Causing Equipment Standard-001.

Cet appareil ISM est conforme à la norme NMB-001 du Canada.

**The C-Tick Mark:** a trademark registered to the Australian Communication Media Authority. It indicates compliance with all Australian EMC regulatory information.

marks the “on” position of the power line switch.

marks the “standby” position of the power line switch.

indicates that the instrument requires AC power input.
This product complies with the WEEE Directive (2002/96/EC) marking requirements. The affixed label indicates that you must not discard this electrical/electronic product in domestic household waste.

Product Category: With reference to the equipment types in the WEEE Directive Annex 1, this product is classed as a Monitoring and Control instrumentation product.

Do not dispose in domestic household waste. To return unwanted products, contact your local Agilent office, or see

http://www.agilent.com/environment/product/
2

Getting Started

Check the Shipment and Order List  14
Safety Notice  17
Environmental Requirements  18
Electrical Requirements  19
Power on and Check  22
Some Tips  25
Connectors Maintenance  28

This chapter presents information to properly configure test connections to your instruments and interfaces for correct use of the signal generator.
Check the Shipment and Order List

After receiving the product shipment, refer to the following procedures to check the shipment contents. If there is any concern about the shipment, please contact Agilent Technologies Customer Contact Center for consultation and service.

- Inspect the shipping container for physical damage. Signs of damage may include a dented or torn shipping container or cushioning material. This may indicate signs of unusual stress or compacting.

- Carefully remove the contents of the shipping container and verify that the order is complete. Each shipment includes the following standard items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>N9310A signal generator</td>
<td>1</td>
<td>N9310A</td>
</tr>
<tr>
<td>USB cable</td>
<td>1</td>
<td>8121-1482</td>
</tr>
<tr>
<td>Three-conductor power cord</td>
<td>1</td>
<td>Specific to region</td>
</tr>
<tr>
<td>Quick Start Guide</td>
<td>1</td>
<td>N9310-90003</td>
</tr>
<tr>
<td>Help kit CD-ROM</td>
<td>1</td>
<td>N9310-84500</td>
</tr>
<tr>
<td>Calibration certificate</td>
<td>1</td>
<td>5962-0476</td>
</tr>
</tbody>
</table>

- If you ordered any of the following options, verify that they are in the shipment by checking the product label on the rear panel and the package check list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Name</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>I/Q modulator</td>
<td>N9310A-001</td>
</tr>
<tr>
<td>1CM</td>
<td>Rack mount kit</td>
<td>N9310A-1CM</td>
</tr>
<tr>
<td>1TC</td>
<td>Hard transit case</td>
<td>N9310A-1TC</td>
</tr>
</tbody>
</table>
Rack Mount

It is recommended to use the rack mount kit (option 1CM) if the signal generator is to be installed into an instrument rack.

Do not attempt to rack mount the signal generator using the front panel handles only. The Agilent rack mount kit will allow the signal generator to be mounted in a rack with or without the handles.

Refer to the following instructions when you rack mount the signal generator.

1. Remove the feet, key-locks and tilt stands, as shown below.

2. Remove side trim strips and a middle screw per side.
3 Attach the rack mount flange and front handle assembly with 3 screws per side.

4 Rack mounting with two dress screws per side.

**CAUTION**
Installing the signal generator into a non-approved rack may promote shock hazards, overheating, dust contamination, and inferior system performance. Consult your Agilent customer engineer about installation, warranty, and support details.

**Transit**

The hard transit case (option 1TC) is recommended for transporting instruments.
Safety Notice

Please read the following warnings and cautions carefully before applying power to the signal generator in order to ensure personal and instrument safety.

**WARNING** Always use a well-grounded, three-pin AC plug and power cord to connect to a power source. Personal injury may occur if there is any interruption of the AC power cord of the signal generator. Intentional interruption is prohibited.

**WARNING** Personal injury may result if the signal generator covers are removed. There are no operator service parts inside. To avoid electrical shock, refer servicing to qualified personnel.

**WARNING** Electrical shock may result if the signal generator is connected with the power supply when cleaning. Do not attempt to clean internally.

**CAUTION** Installing the signal generator in non-approved rack systems may promote shock hazards, overheating, dusting contamination, and inferior system performance. Consult to your Agilent customer engineer about installation, warranty, and support details.

**CAUTION** Damage to the signal generator may result when the total power dissipated in the system cabinet is greater the 800 watts. When this condition exists, forced convection must be applied.

**CAUTION** Avoid turning off the signal generator when current state is changing as a result of front panel operation or remote control.
Environmental Requirements

Agilent Technologies has designed this product for use in Installation Category II, POLLUTION DEGREE 2, per IEC 61010-1. Agilent has designed the signal generator for use under the following conditions:

- Indoor use
- Altitude < 3,000 meters
- Temperature 0 to 45°C, unless otherwise specified
- 15% to 95% relative humidity for temperatures at 40°C

Ventilation

Ventilation holes are located on the rear panel and all four sides of the signal generator cover. Do not allow these holes to be obstructed, as they allow air flow through the signal generator.

When installing the signal generator in a cabinet, do not restrict the convection airflow into or out of the signal generator. The ambient temperature outside the cabinet must be less than the maximum operating temperature of the signal generator by 4°C for every 100 watts dissipated within the cabinet.

Cleaning Tips

To prevent electrical shock, disconnect the signal generator from the main AC power circuits before cleaning. Use a dry cloth or one slightly dampened with water to clean the external case parts. Do not attempt to clean internally.

**WARNING**

Electrical shock may result if the signal generator is connected to the AC power supply while cleaning. Disconnect from any AC power source before cleaning. Do not attempt to clean internally.
Electrical Requirements

The signal generator has an auto-ranging line voltage internal power supply input. The available AC power source must meet the following conditions:

<table>
<thead>
<tr>
<th>Voltage:</th>
<th>100~240 volts nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency:</td>
<td>50/60 Hz nominal</td>
</tr>
<tr>
<td>Power:</td>
<td>100 watts maximum</td>
</tr>
</tbody>
</table>

Connecting the AC Power Cord

This Safety Class I Product is provided with a protective earth ground incorporated into the power cord. The front panel switch is a standby switch only; it is not an AC power switch. The AC power cord is a disconnecting device that may be used to disconnect the signal generator from the main AC supply. Alternately, The rear panel switch or circuit breaker may also be used as a disconnecting device.

Perform the following steps to connect the AC power cord:

• Ensure that the power cord is not damaged.
• Install the signal generator so that you can easily reach the AC power cord or circuit breaker.
• Insert the main plug into a socket outlet provided with a protective earth grounding.
### AC Power Cord Localization

<table>
<thead>
<tr>
<th>Plug Type</th>
<th>Cable Part Number</th>
<th>Plug Description</th>
<th>For Use in Country &amp; Region</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="plug.png" alt="250V 10A" /></td>
<td>8121-1466</td>
<td>BS 1363/A</td>
<td>Option 900 United kingdom, Hong Kong, Singapore, Malaysia</td>
</tr>
<tr>
<td><img src="plug.png" alt="250V 10A" /></td>
<td>8120-1454</td>
<td>KS C8305</td>
<td>Option 902 Korea</td>
</tr>
<tr>
<td><img src="plug.png" alt="250V 10A" /></td>
<td>8120-1378</td>
<td>CNS 10917-2</td>
<td>Option 903 Unite States, Canada, Taiwan</td>
</tr>
<tr>
<td><img src="plug.png" alt="125V 12A" /></td>
<td>8120-4754</td>
<td>JIS C8303</td>
<td>Option 918 Japan</td>
</tr>
<tr>
<td><img src="plug.png" alt="250V 10A" /></td>
<td>8120-8377</td>
<td>GB 1002</td>
<td>Option 922 China</td>
</tr>
</tbody>
</table>

a. Plug identifier numbers describe the plug only. The part number is for the complete cable assembly.
Electrostatic Discharge Protection

Electrostatic discharge (ESD) damages or destroys electronic components (the possibility of unseen damage caused by ESD is present whenever transportation, store or use of components).

This product contains components that are easily damaged by Electrostatic Discharge (ESD). To help reduce ESD damage that can occur while using test equipment:

1. Each day, before connecting any coaxial cables to the signal generator connector, momentarily short the center and outer conductors of the cable together.

2. Before touching the center pin of any connector, and before removing any assembly from the signal generator, users must be grounded with a 1 MΩ resistor-isolated wrist-strap.

3. Be sure that all instruments are properly grounded to prevent build-up of static charges.

For more information about ESD and how to prevent ESD damage, contact the Electrostatic Discharge Association (http://www.esda.org). The ESD standards developed by this agency are sanctioned by the American National Standards Institute (ANSI).
Power on and Check

1 Connect the power cord. Insert the plug into a power socket provided with a protective earth ground contact. Set the tilt adjustor for your preference.

2 Connect a cable to the RF output connector of the signal source to the DUT (device under test).
Turn On the Signal Generator

1. Toggle the rear panel line switch to the On state. The orange front panel standby LED will light and the signal generator will then have AC line power.

2. Pressing the standby switch on the front panel, will turn on the signal generator and the green Switch On LED will light.

Self-initialization (boot up) will take about 30 seconds, including self-test. If an error is detected, the signal generator will report an error. The signal generator will then default to a maximum frequency of 3 GHz and a minimum amplitude of –127 dBm. The signal generator is then ready for use. After power on, the signal generator requires approximately 45 minutes for temperature stabilization.

**NOTE**

The front panel switch is a standby power switch only; it does not turn off AC line power. To completely disconnect the signal generator from the line power, turn off the power switch located on the rear panel.
Check for Error Messages

There are two categories of instrument messages. System messages and error messages. A system message is triggered by operation errors. For example, parameter setting conflicts or data input that is out of the parameter range. An error message may be triggered by hardware defects and will have an \textit{ERR} annunciator displayed on the screen.

If an operational error occurs, the signal generator will report a message displayed at the bottom of the screen. It will indicate an operation error has occurred and that the instrument has corrected the error. The signal generator will automatically clears system messages after 30 seconds.

If a hardware defect or system error occurs, the signal generator will report a message at the bottom of the screen and will also have an \textit{ERR} annunciator displayed.

Here are some tips for checking for error messages in the signal generator:

1. Check the display to see if the \textit{ERR} annunciator is displayed. If it is, press \text{Utility} > \text{Error Info} to review each error message in the error queue (list). Refer to Chapter 7, “Instrument Messages,” starting on page 173 for detailed system messages descriptions.

2. When you have reviewed and resolved all of the error messages, press \text{Utility} > \text{Error Info} > \text{Clear} softkey to delete the messages.

3. Cycle the AC power to the signal generator and then check again to see if the \textit{ERR} annunciator has turned off.

4. If you can not resolve the error messages, please contact the Agilent Customer Contact Center for assistance.
Some Tips

Refer to the following hints to set up the signal generator for your preference. For more detailed description, see Chapter 4, “Utility,” starting on page 84.

- Press Utility > Screen Saver > On to set the screen saver on. With the screen saver set to On, the display will turn off after 15 minutes if there is no input from the front panel. Press any front panel key to turn the display back on.
- Select a display style by pressing Utility > Display Style

The display style and the screen saver are persistent state, pressing hardkey will not affect these settings.

- Save the current configuration for frequent use to either local memory or an external USB memory.
- Connect and set an external reference by pressing Utility > Ref Setups
- Connect an external display monitor to the VGA connector for educational projects or other needs.

Enable an option

You are required to enter the option license key to enable the option. Contact your nearest Agilent Office for purchasing a license. Refer to the following steps to enable the I/Q modulator (option 001):

1. Press Utility hardkey
2. Press License key softkey
3. Enter the license key information and the option will be enabled immediately
Remote Control

The configuration for setting up remote control for your N9310A is done very simply. You need only to connect your N9310A with a PC which has installed Agilent IO Libraries Suite using an appropriate USB cable.

If you need a more flexible remote control, you can also create your own program by using Agilent VTL (Visa Transition Library and the SCPI commands.

For more information about N9310A SCPI commands and programming examples, refer to Chapter 6, “Subsystem Command Reference,” starting on page 105.

For more information about Agilent IO Libraries Suite, refer to http://www.agilent.com/find/iolib

If you are new to instrument programming, please refer to Chapter 5, “Programming Fundamentals,” starting on page 89.
Firmware Update

The N9310A provides a convenient firmware update service. Please refer to this procedure to finish the firmware update:

1. Download the firmware (ZIP file) from
http://www.agilent.com/find/n9310a

Refer to the following flow chart for downloading:

![Flow chart for downloading firmware](image)

2. Extract the ZIP file, you will get the file `N9310A.update`, then copy this file into the root directory of your USB memory stick.

3. Power off your N9310A and insert this USB memory stick into the USB connector on the front panel.

4. Power on your N9310A, then press [Enter] to begin the upgrade process.

5. The entire upgrade procedure will take several minutes. Please wait until the instructions are displayed before removing the USB memory stick. The instrument will then show that new firmware is available for use after rebooting the instrument.

Press Utility > Information to view the current firmware information.

**NOTE**

The instrument firmware contains drivers for most USB memory sticks. Please make sure your USB memory stick is in FAT16 or FAT 32 format. The N9310A does not support USB memory sticks with self-startup partition or multi-partitions.
Connector Maintenance

The RF connectors should be checked every six months—more often if the instrument is in daily use on a production line or in a harsh environment. Visually inspect the front panel connectors. The most important connectors are those to which the DUT (device under test) is connected, typically the RF cable end or the RF OUT and LF OUT connectors. All connectors should be clean and the center pins centered. The fingers of female connectors should be unbroken and uniform in appearance. If unsure whether the connectors are in good condition, gauge the RF OUT connectors to confirm their dimensions are correct.

**Maximum and minimum protrusion of center conductor from mating plane**

Min. = 0.204 in.  Max = 0.207 in.
3

Using Functions

Commonly used Front-panel Elements  30
Generating a CW Signal  31
Generating a Step Swept Signal  32
Generating a List Swept Signal  39
Generating a Modulated Signal  41
Generating an LF Output  49
Save, Recall and Delete an Instrument State  50

This chapter contains procedures that illustrate how to use the major functions of your signal generator. They include setting frequency and power levels, setting up modulations, creating RF and LF sweeps, saving and recalling instrument states, and enabling options.
Commonly used Front-panel Elements

In addition to using basic function hardkeys, a user will also enter data using softkeys and selection from menu softkeys. If you are new user of the N9310A, refer to the following tips on entering data and using softkeys.

**Entering Data**

When setting the parameter values, there are two ways of entering or modifying values for an active function:

**Using the numeric keypad and the unit softkey**

- **Numeric Keypad** Enters a specific value.
- **Unit softkey** Terminates a data input by softkey menu keypad

**Using the knob, arrow keys and the Enter hardkey**

- **Knob** Increases or decreases a parameter value
- **Arrow Keys** Used to move to the selected item to be modified or input
- **Enter** Confirms and terminates the data input

**Using Softkeys**

Softkeys, which are located to the right side of the display, provide access to many sub-functions. There are three types of softkeys being used in N9310A. See the table below to learn their types and functions.

<table>
<thead>
<tr>
<th>Type</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle</td>
<td>Pressing this type of softkey toggles a parameter between two states</td>
<td>AM On Off</td>
</tr>
<tr>
<td>Submenu</td>
<td>Pressing this type of softkey enter another submenu</td>
<td>Configure Stop Sweep</td>
</tr>
<tr>
<td>Modify</td>
<td>Pressing this type of softkey enables you to modify a parameter value</td>
<td>AM Rate 1.000 kHz</td>
</tr>
</tbody>
</table>
Generating a CW Signal

Generating a CW (Continuous Wave) signal requires you to select the frequency and amplitude parameters and enable the RF output. The parameters have the following characteristics:

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>9 kHz to 3 GHz</td>
<td>3.0000000000 GHz, with 0.1 Hz resolution</td>
</tr>
<tr>
<td>Amplitude</td>
<td>–127 to +13 dBm (+20 dBm settable)</td>
<td>–127 dBm, with 0.1 dB resolution</td>
</tr>
<tr>
<td></td>
<td>–80 to +60 dBmV (+67 dBmV settable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>–20 to +120 dB μV (+127 dB μV settable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.0001 to 1000 mV (2238.8 mV settable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.1 to 1000000 μV (2238800 μV settable)</td>
<td></td>
</tr>
</tbody>
</table>

**Operation Example**

Assume you need to generate a CW signal with:

- a frequency of 700 MHz
- an amplitude of –20 dBm

Please refer to the following steps to set up the CW signal:

1. Press the **Preset** hardkey
   This returns the signal generator to the factory default state. To view the default settings of the signal generator, please check Chapter 4, “Factory Default Settings,” starting on page 70.

   Observe the FREQUENCY and AMPLITUDE area of the display (in the upper left-hand corner). The value displayed is the maximum frequency (3 GHz) and the minimum amplitude (–127 dBm), the default conditions.

2. Press the **Frequency** > **700** > **MHz** to set the CW frequency to 700 MHz.
3. Press the **Amplitude** > **–20** > **dBm** to set the CW amplitude to –20 dBm.
4. Toggle the **RF On/Off** hardkey to enable the RF output.
Generating a Step Swept Signal

The signal generator will generate step swept signals in three sweep modes:

<table>
<thead>
<tr>
<th>Sweep Mode</th>
<th>Sweep Range</th>
<th>Front-panel key access</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF</td>
<td>9 kHz to 3 GHz</td>
<td>Sweep &gt; Sweep Mode &gt; RF</td>
</tr>
<tr>
<td>Amplitude</td>
<td>–127 to +13 dBm</td>
<td>Sweep &gt; Sweep Mode &gt; Ampl</td>
</tr>
<tr>
<td>LF</td>
<td>20 Hz to 80 kHz</td>
<td>Sweep &gt; Sweep Mode &gt; LF</td>
</tr>
</tbody>
</table>

During the swept RF output or Amplitude output, the FREQUENCY and AMPLITUDE display are deactivated.

**General Settings for a Step Sweep**

It is necessary to set up the following parameters for a step sweep function:

- start and stop frequency/amplitude
- the number of equally spaced frequency points (steps) the RF output will dwell upon
- the dwell time at each point

For more information on how to generate a step sweep, refer to:

“Generating an RF Sweep” on page 35,
“Generating an Amplitude Sweep” on page 37,
“Generating an LF Sweep” on page 38.
Additional Settings for a Step Sweep

There are four other settings that will have an effect on the sweep:

- **Sweep Trigger:**
  The sweep trigger can be set to any of the following three choices: **Immediate/Trigger Key/EXT**

- **Point Trigger:**
  The point trigger can be set to any of the following three choices: **Immediate/Trigger Key/EXT**

- **Sweep Repeat: Cont/Single**
  The sweep repeat can be set to either **Cont** or **Single**.
  If set to **Cont**, the signal generator sweeps from the start point to the stop point and repeats continuously.
  If set to **Single**, the signal generator sweeps from the start point to the stop point for one sweep only.

- **Sweep Direction: Up/Down**

For example, as you enable the RF sweep by pressing **Sweep > Sweep Mode > RF**, the signal generator will perform as shown below, depending on the combination of settings for sweep and point trigger.
3 Using Functions

<table>
<thead>
<tr>
<th>Sweep Trigger</th>
<th>Point Trigger</th>
<th>Sweep Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMM</td>
<td>IMM</td>
<td>Pressing $\text{Sweep &gt; Sweep mode &gt; RF}$ starts a continuous sweep mode. Pressing $\text{Sweep &gt; Sweep mode &gt; Off}$ will stop the sweep.</td>
</tr>
<tr>
<td>IMM</td>
<td>Key</td>
<td>Pressing $\text{Sweep &gt; Sweep mode &gt; RF}$ enables the RF sweep, then pressing the $\text{Trigger key}$ will initiate manual sweeping over the defined points.</td>
</tr>
<tr>
<td>Key</td>
<td>IMM</td>
<td>Pressing $\text{Sweep &gt; Sweep mode &gt; RF}$, the &quot;ARMED&quot; annunciator will be displayed, indicating the signal generator is ready for trigger instruction. Pressing $\text{Trigger key}$ starts the signal generator sweeping over the points automatically.</td>
</tr>
<tr>
<td>Key</td>
<td>Key</td>
<td>Pressing $\text{Sweep &gt; Sweep mode &gt; RF}$, the &quot;ARMED&quot; annunciator displays on the screen, indicating the sweep is ready for the trigger. Pressing $\text{Sweep &gt; Sweep mode &gt; RF}$ enables an RF sweep, then pressing the $\text{Trigger key}$ will initiate a manual point sweep.</td>
</tr>
</tbody>
</table>

To use an external trigger source, a TTL signal with 100 ns as the minimum level holding time is required. The sweep trigger must be set to $\text{Key}$ and the point trigger set to $\text{EXT}$, for the sweep to be set to either $\text{Single}$ or $\text{Cont}$. Other combinations of sweep and point trigger will allow continuous sweep only.
Generating an RF Sweep

To generate an RF sweep with the following settings:

- frequency range from 1 GHz to 2 GHz, at a power level of 0 dBm
- nine sweep points with a 50 ms dwell time at each point

Refer to the following procedures to configure and generate an RF sweep:

1. Press \textcolor{green}{\text{Preset}} hardkey
2. Press \textcolor{red}{\text{Amplitude}} > 0 > \text{dBm}
   To set the RF sweep output level at 0 dBm.
3. Press \textcolor{red}{\text{Sweep}} hardkey
   To open the sweep submenus.
4. Press \textcolor{blue}{\text{Step Sweep}} softkey
   To open a submenu for step sweep configurations.
5. Press \textcolor{red}{\text{RF Start}} > 1 > GHz
   To set the start frequency of the sweep to 1 GHz.
6. Press \textcolor{red}{\text{RF Stop}} > 2 > GHz
   To set the stop frequency of the sweep to 2 GHz.
7. Press \# Points > 9 > Enter
   To set the number of sweep points to nine.
8. Press \textcolor{red}{\text{More(1/2)}} > \text{Step Dwell} > 50 > ms
   To set the dwell time at each point to 50 ms.
9. Press \textcolor{red}{\text{RF On/Off}} hardkey to enable the RF output.
   The annunciator will change from \textcolor{red}{\text{RF Off}} to \textcolor{green}{\text{RF On}}.
10. Press \textcolor{red}{\text{Return}} > \text{Sweep Mode} > RF

This enables the RF sweep and initiates the signal generator to sweep immediately and automatically. A **Sweep** annunciator is displayed for the duration of the sweep.

**NOTE**

When presetting the instrument, the sweep and point trigger settings default to **Immediate**. For more information about how to use different trigger modes, refer to "Additional Settings for a Step Sweep" on page 33.

For more information about the sweep settings, refer to Chapter 4, “Sweep,” starting on page 73.
Generating an Amplitude Sweep

To generate an amplitude sweep with the following settings:

- amplitude ranges from –80 to –60 dBm, at a frequency of 1 GHz
- 9 sweep points, 50 ms dwell time at each point

Refer to the following steps to configure and generate an amplitude sweep:

1. Press **Preset** hardkey
2. Press **Frequency > 1 > GHz**
3. Press **Sweep** hardkey
4. Press **Step Sweep** softkey
5. Press **# Points > 9 > Enter**
6. Press **More > Ampl Stop > –60 > dBm**
7. Press **Ampl Stop > –80 > dBm**
8. Press **Step Dwell > 50 > ms**
9. Press **RF On/Off** hardkey to enable the RF output.
10. Press **Return > Sweep Mode > Ampl** to enable the amplitude sweep immediately. A **SWEEP** annunciator displays for the duration of the sweep.

For more information about the sweep settings, please refer to Chapter 4, “Sweep,” starting on page 73.
Generating an LF Sweep

To generate an LF sweep with the following settings:

- frequency range, 10 to 60 kHz, at a level of 500 mV
- six sweep points and 50 ms dwell time at each point

Pressing **Preset** sets the sweep/point trigger to Immediate (IMM) and the LF output amplitude to 500 mV. The following procedures do not include the steps to set the sweep/point trigger and the LF output amplitude.

Refer to the following procedures to configure and generate an LF sweep:

1. Press **Preset** hardkey
2. Press **Sweep** hardkey
3. Press **Step Sweep** softkey
4. Press **LF Start > 10 > kHz**
5. Press **LF Stop > 60 > kHz**
6. Press **# Points > 6 > Enter**
7. Press **Step Dwell > 50 > ms**
8. Press **Return > Sweep State > LF**

This initiates the LF sweep output immediately via the LF OUT connector. A **SWEEP** annunciator displays for the duration of the sweep.

For more information about the sweep settings, please refer to Chapter 4, “Sweep,” starting on page 73.
Generating a List Swept Signal

List sweep allows you to create a list of arbitrary frequency, amplitude, and dwell time values and sweep the output based on the entries in the List Mode Values table.

The signal generator allows you to generate list swept signals in three modes:

<table>
<thead>
<tr>
<th>Sweep Mode</th>
<th>Sweep Range</th>
<th>Front-panel key access</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF</td>
<td>9 kHz to 3 GHz</td>
<td>&gt; Sweep Mode &gt; RF</td>
</tr>
<tr>
<td>Amplitude</td>
<td>−127 to +13 dBm</td>
<td>&gt; Sweep Mode &gt; Ampl</td>
</tr>
<tr>
<td>RF&amp;Ampl</td>
<td>9 kHz to 3 GHz, −127 to +13 dBm</td>
<td>&gt; Sweep Mode &gt; RF&amp;Ampl</td>
</tr>
</tbody>
</table>

List sweep frequencies and amplitudes can be entered at unequal intervals, nonlinear ascending/descending, or random order. Unlike a step sweep that contains linear ascending/descending frequency and amplitude values spaced at equal intervals throughout the sweep.

In List Swept Mode both the RF mode and the Amplitude mode are similar to their functions in step sweep, except for the differences stated above. Thus we will only discuss some detail operational procedures for RF&Ampl, which could also be referenced when you are using the RF mode or the Amplitude mode. Note that in the RF mode all signals share the same amplitude while in the Amplitude mode all signals share the same frequency.
Refer to the following procedure to configure and generate an RF&Ampl sweep:

1. Press the **Preset** hardkey.
2. Press **Sweep** > **Sweep Type** > **List**.
3. Press **List Sweep** > **Insert Row** to input your list sequence data.
4. Using the knob to highlight the item to edit, input the desired value and terminate that input with a unit key.
5. Press **Return** to go up one menu level when all data values have been entered for the testing sequence.
6. Press **More(1/2)** softkey, to go to the next menu page.
7. Press **Sweep Trigger** > **Trigger Key**.
8. Press **Point Trigger** > **Immediate**.
9. Press **More(2/2)** softkey, to return to the previous menu page.
10. Press **Sweep Mode** > **RF & Ampl**.
11. Press the **RF On/Off** hardkey to enable the RF output.
12. Press the **Trigger** hardkey on the front panel.

This will enable the list sweep function and start the frequency and amplitude sweep immediately and automatically.

**NOTE**

When presetting the instrument, the default setting for sweep trigger and point trigger is **Immediate**. For more information about using different trigger modes and how to set **Sweep Direction** and **Sweep Repeat**, refer to “Additional Settings for a Step Sweep” on page 33. They function similar to these modes in a list sweep.
Generating a Modulated Signal

The N9310A will generate the following modulated signals: AM, FM, ΦM, Pulse Modulation. An optional I/Q modulator is also available with Option 001.

Preparing the Modulation Format

The modulation format can be turned before or after setting the other modulation parameters. To turn on the modulation format and output a modulated signal, perform the following steps:

1. For example, press the AM hardkey, to access the submenu for this modulation format.

   This submenu shows a set of softkeys associated with the format’s name. For example, AM Depth, AM Source.

2. Press the Mod On/Off hardkey until MOD/ON is displayed. And press the RF On/Off key to enable the RF output.

More examples about generating a modulated signal are shown on the following pages.
Simultaneous Modulations

The signal generator can generate multiple modulation formats simultaneously. The following table some of the capability to generate the simultaneous modulation formats.

<table>
<thead>
<tr>
<th></th>
<th>AM (INT)</th>
<th>AM (EXT)</th>
<th>I/Q</th>
<th>FM (INT)</th>
<th>FM (EXT)</th>
<th>FM</th>
<th>Pulse (INT)</th>
<th>Pulse (EXT)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM (INT)</td>
<td></td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>AM (EXT)</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>I/Q</td>
<td>●</td>
<td></td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>FM (INT)</td>
<td>●</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>FM (EXT)</td>
<td>●</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>FM</td>
<td>●</td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Pulse (INT)</td>
<td></td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Pulse (EXT)</td>
<td></td>
<td>●</td>
<td></td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
Generating an AM signal

The signal generator generates AM (amplitude modulated) signals with the following basic settings:

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM Depth</td>
<td>0.0 to 100.0%</td>
<td>0.0</td>
</tr>
<tr>
<td>AM Source</td>
<td>Internal source (INT)</td>
<td>INT</td>
</tr>
<tr>
<td></td>
<td>External source (EXT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Combined INT and EXT</td>
<td></td>
</tr>
<tr>
<td>AM Rate</td>
<td>20 Hz to 80 kHz (INT)</td>
<td>1.0000 kHz, 0.1 Hz resolution</td>
</tr>
<tr>
<td></td>
<td>DC/20 Hz to 80 kHz (EXT)</td>
<td></td>
</tr>
</tbody>
</table>

Operation Example

To generate an AM signal with the following parameters:
- Carrier frequency of 1 GHz, amplitude of –10 dBm
- AM depth of 70%
- AM rate at 15 kHz
- Internal AM source (default by)

Refer to the following to configure the signal generator for the above described AM output:

1. Press \( \text{Preset} \) presets the signal generator
2. Press \( >1> \text{GHz} \) sets the CW frequency to 1 GHz
3. Press \( >-10>- \text{dBm} \) sets the CW amplitude to –10 dBm
4. Press \( \text{AM} \) enters the AM submenu
5. Press \( \text{AM Depth} >70> \% \) sets AM depth to 70%
6. Press \( \text{AM Rate} >15> \text{kHz} \) sets AM rate to 15 kHz
7. Press \( \text{AM On} \) enables AM
8. Press \( \text{On} \) enables the AM signal output

For key reference, please refer to “AM” on page 54.
Generating an FM Signal

The N9310A will generate FM (frequency modulated) signals with the following basic settings:

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>FM Deviation</td>
<td>20 Hz to 100 kHz</td>
<td>20 Hz, 1 Hz resolution</td>
</tr>
<tr>
<td>FM Source</td>
<td>Internal source (INT)</td>
<td>INT</td>
</tr>
<tr>
<td></td>
<td>External source (EXT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Combined INT and EXT</td>
<td></td>
</tr>
<tr>
<td>FM Rate</td>
<td>20 Hz to 80 kHz (INT)</td>
<td>1.0000 kHz, 0.1 Hz resolution</td>
</tr>
<tr>
<td></td>
<td>DC/20 Hz to 80 kHz (EXT)</td>
<td></td>
</tr>
</tbody>
</table>

Operation Example

To generate an FM signal with the following parameters:

- Carrier frequency of 1 GHz, amplitude of –10 dBm
- FM deviation of 50 kHz
- FM rate at 30 kHz
- Internal FM source (default by  )

Refer to the following to configure your signal generator for the above signal type:

1. Press  presets the signal generator
2. Press  > 1 > GHz sets the CW frequency to 1 GHz
3. Press  > –10 > dBm sets the CW amplitude to –10 dBm
4. Press  enters the FM submenu
5. Press  FM Deviation > 50 > kHz sets FM deviation to 50 kHz
6. Press  FM Rate > 30 > kHz sets FM rate to 30 kHz
7. Press  FM > On enables FM
8. Press  hardkey to RF On enables FM signal output.

For key reference, please refer to “FM” on page 61.
Generating a Phase Modulated Signal

The signal generator generates phase modulated (ΦM) signals with the following characteristics:

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>ΦM Deviation</td>
<td>0 to 10 rad (300 Hz ≤ ΦM rate ≤ 10 kHz)</td>
<td>0.000 rad, with 0.001 rad resolution</td>
</tr>
<tr>
<td>ΦM Deviation</td>
<td>0 to 5 rad (10 kHz &lt; ΦM rate ≤ 80 kHz)</td>
<td></td>
</tr>
<tr>
<td>ΦM Source</td>
<td>Internal source only</td>
<td>N/A</td>
</tr>
<tr>
<td>ΦM Rate</td>
<td>300 Hz to 80 kHz</td>
<td>1.0000 kHz, with 0.1 Hz resolution</td>
</tr>
</tbody>
</table>

**Operation Example**

To generate a ΦM signal with the following characteristics:

- Carrier frequency of 1 GHz, amplitude of –10 dBm
- ΦM deviation of 7.3 rad
- ΦM rate at 10 kHz

The following procedure will configure the N9310A to generate the above signal:

1. Press [Preset] presets the signal generator (default settings).
2. Press > 1 > GHz sets the CW frequency to 1 GHz.
3. Press > –10 > dBm sets the CW amplitude to –10 dBm.
4. Press ΦM enters the ΦM submenu.
5. Press ΦM Deviation > 7.3 > rad sets ΦM deviation to 7.3 rad.
6. Press ΦM Rate > 10 > kHz sets ΦM rate to 10 kHz.
7. Press ΦM On off enables ΦM.
8. Press RF On/Off to On enables ΦM signal output.

For key reference, please refer to Chapter 4, “Phase Modulation,” starting on page 67.
Generating a Pulse Modulated Signal

The N9310A will generate pulse modulated signals with the following characteristics:

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Source</td>
<td>Internal source (INT)</td>
<td>INT</td>
</tr>
<tr>
<td></td>
<td>External source (EXT)</td>
<td></td>
</tr>
<tr>
<td>Pulse Period</td>
<td>200 μs to 2 s (INT and EXT)</td>
<td>200 μs, with 1 μs resolution</td>
</tr>
<tr>
<td>Pulse Width</td>
<td>100 μs to 1 s (INT and EXT)</td>
<td>100 μs, with 1 μs resolution</td>
</tr>
</tbody>
</table>

Operation Example

To generate a pulse modulated signal with the following characteristics:

- Carrier frequency of 1 GHz, amplitude of –10 dBm.
- Pulse period of 10 ms.
- Pulse width of 6 ms.
- Internal pulse source (default by ).

The following procedure will configure the N9310A to generate the above signal:

1. Press \[ \text{Preset} \] presets the signal generator (default settings).
2. Press \[ \text{Frequency} > 1 > \text{GHz} \] sets the CW frequency to 1 GHz.
3. Press \[ \text{Amplitude} > –10 > \text{dBm} \] sets the CW amplitude to –10 dBm.
4. Press \[ \text{Pulse} \] enters the Pulse modulation submenu.
5. Press \[ \text{Pulse Period} > 10 > \text{ms} \] sets pulse period to 10 ms.
6. Press \[ \text{Pulse width} > 6 > \text{ms} \] sets pulse width to 6 ms.
7. Press \[ \text{Pulse On/Off} \] enables pulse modulation.
8. Press \[ \text{On} \] enables pulse modulated signal output.

For key reference, please refer to Chapter 4, “Pulse,” starting on page 71.
Generating an I/Q Modulated Signal (Option 001 Only)

The N9310A generates I/Q modulated signals with the following characteristics:

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/Q Source</td>
<td>External source only</td>
<td>N/A</td>
</tr>
<tr>
<td>I/Q Input</td>
<td>50 Ω impedance, VSWR &lt; 1.5, Full scale input &lt; 0.5 Vrms</td>
<td>N/A</td>
</tr>
<tr>
<td>I/Q Input Connector</td>
<td><strong>EXT I</strong> and Q connector on rear panel (BNC type, female)</td>
<td>N/A</td>
</tr>
</tbody>
</table>

When using a constant sum vector modulation of $\sqrt{I^2 + Q^2} = 0.5$ V to drive the I/Q modulator, the actual RF level corresponds to the displayed RF level. To avoid over driving the I/Q modulator, the sum vector must never exceed 0.5 V when using I/Q modulation. For full-scale input, the peak envelope power of the modulated RF signal is equal to the indicated LEVEL. The average power will be less.

$$\text{Amplitude} = \frac{\sqrt{I^2 + Q^2}}{0.5V} \text{ input value LEVEL}$$
3 Using Functions

Operation Example

To generate an I/Q modulated signal with 1 GHz carrier frequency, and an amplitude of –10 dBm.

The following procedure will configure the N9310A to generate the above signal:

1 Connect the external I/Q source to the BNC I and Q inputs on the rear panel of the signal generator
2 Press \text{ Preset} presets the signal generator
3 Press \text{ Frequency} > 1 > \text{ GHz} sets the CW frequency to 1 GHz
4 Press \text{ Amplitude} > –10 > \text{ dBm} sets the CW amplitude to –10 dBm
5 Press \text{ I/Q} enters the I/Q modulation submenu
6 Press \text{ I/Q On/Off} enables I/Q modulation
7 Press \text{ RF On/Off} enables I/Q modulated signal output.
Generating an LF Output

The N9310A can generate an LF (Low Frequency) signal with the following characteristics. A Low frequency signal is typically called the audio frequency.

<table>
<thead>
<tr>
<th>Character</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>20 Hz to 80 kHz</td>
<td>1.0000 kHz, with 0.1 Hz resolution</td>
</tr>
<tr>
<td>Amplitude</td>
<td>0 to 3 V (peak)</td>
<td>500 mV, with 1 mV resolution</td>
</tr>
<tr>
<td>Output Connection</td>
<td>LF OUT connector on the front panel (BNC type, 50 Ω)</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Operation Example

To generate an LF signal with:
- a frequency of 10 kHz
- an amplitude of 3 V

Refer to the following steps to generate the LF signal:
1. Press LF Out enters submenu of LF output function.
2. Press LF Out Freq > 10 > kHz sets LF frequency to 10 kHz
3. Press LF Out Ampl > 3 > V sets LF amplitude to 3 V
4. Press LF Out On/Off to On state enables LF output.
Save, Recall and Delete an Instrument State

This section describes how to use the functions located under the front-panel File key. You can save the instrument state information to either local memory or external to a USB memory stick or disk. The output file format of a configuration file is *.cfg (file extension type). You can also recall the saved files from local memory or an external flash memory for a quick start of commonly used or custom (unique) instrument configurations.

**NOTE**
Set the file catalog to Local before unplugging a USB memory stick from the USB connector on the front or rear panel of the signal generator.

### Saving an Instrument State

Instrument state configurations are saved in the file format of “<file name>.cfg”, such as “sample.cfg”. The file name can be modified with the 26 lowercase letters from a to z and 10 arabic numbers from 0 to 9.

The signal generator provides up to 20 files memory spaces in the local memory.

**Saving an instrument state in the local memory**

Use the following steps to save an instrument state configuration to local memory:

1. Press File > Catalog > Local sets file catalog to local memory.
2. Press Save softkey. This will enable editing of a file name for the instrument state you are saving.
3. Edit or input the file name by rotating the knob and pressing Next softkey to enter each letter or number.
4. Press Save now softkey to confirm the file name and save the instrument state into local memory.

Refer to the example on the next page for how to editing the file name.
How to edit a file name

To save an instrument state with the filename “sample”, refer to following process:

1. Press Save to enable editing the file name. The signal generator automatically presents an “a” as the first letter.
2. Rotate the knob until the first letter is an “s”.
3. Press Next to confirm the first letter and the instrument will automatically present an “a” as the second letter.
4. Repeat step 2 and step 3, to edit the filename “sample” is completed.
5. Press Save now to confirm the filename and saves the instrument state as “sample.cfg” to the local memory.

Saving an instrument state to an external USB memory stick

Refer to the following steps to save an instrument state to a USB memory stick or disk:

1. Press Catalog > USB to set the file catalog to USB.
2. Press Save softkey to enable editing of the filename for the instrument state to save.
3. Edit the file name by rotating the knob. Select the correct letter or number, and press the Next softkey for entering the next letter.
4. Press the Save now softkey to confirm the file name and save the instrument state onto the external USB memory stick.
Recalling an Instrument State

You can recall a previously saved instrument state from both local memory or an external USB memory stick.

Recalling an instrument state from the local memory

Refer to the following steps to recall an instrument state from the local memory:

1. Press File > Catalog > Local to set file catalog to Local.
2. Rotate the knob to choose a file from the local directory.
3. Press the Recall softkey to recall the file.

Recalling an instrument state from an external flash memory

Refer to the following steps to recall an instrument state from the external memory:

1. Press File > Catalog > USB to set the file catalog to an external USB port. Insert an external memory stick or disk into one of the port on the instrument.
2. Rotate the knob to select the correct file.
3. Press Recall now to recall the file. The instrument will automatically set the instrument parameters per the file data.

Delete an Instrument State

Refer to the following steps to delete an instrument state (configuration file) from the local memory:

1. Set file catalog to Local or USB.
2. Rotate the knob to select the file to be deleted.
3. Press the Delete softkey.
4. Press the Delete now softkey to confirm and delete the file.

**NOTE**

It is impossible to recover files after pressing Delete now. To abort the file deletion, press the Return softkey instead.
This chapter describes the front panel hardkeys and associated softkeys, and the default value for each key. The chapter is organized alphabetically by front panel hardkey. Each section in this chapter illustrates the softkey menus and their descriptions.
AM

Pressing \textit{AM} hardkey reveals a submenu for AM configurations.

<table>
<thead>
<tr>
<th>AM On/Off</th>
<th>Toggles amplitude modulation state between on and off</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM Depth</td>
<td>Sets amplitude modulation depth</td>
</tr>
<tr>
<td>AM Source</td>
<td>Enters amplitude modulation source submenu:</td>
</tr>
<tr>
<td>INT</td>
<td>Selects internal AM source</td>
</tr>
<tr>
<td>EXT</td>
<td>Selects external AM source</td>
</tr>
<tr>
<td>INT+EXT</td>
<td>Selects internal and external AM source</td>
</tr>
<tr>
<td>AM Rate</td>
<td>Sets amplitude modulation frequency</td>
</tr>
<tr>
<td>AM Waveform</td>
<td>Selects amplitude modulation waveform</td>
</tr>
<tr>
<td>Sine</td>
<td>Selects sine amplitude modulation waveform</td>
</tr>
<tr>
<td>EXT Coupling</td>
<td>AC/DC</td>
</tr>
</tbody>
</table>

\textbf{AM On Off} Pressing this softkey menu selection toggles the amplitude modulation (AM) between on and off. An \textit{AM} annunciator will be displayed on the screen after enabling AM. However, the amplitude modulation will only be processed when the modulation is turned on by pressing the \textit{AM} hardkey.

- Default value: \textit{Off}
- Key sequence: \textit{AM} > AM On Off
**AM Depth**

Press this softkey menu selection to enter the AM depth value. The active entry area of the display will show the current AM depth value. The AM Depth range is from 0 % to 100 %, with minimum increment of 0.1 %.

- Default value: 0.0 %
- Key sequence: AM > AM Depth

**AM Source**

Pressing this softkey reveals a softkey menu of selections for amplitude modulation sources. Select from internal source, or external source from the MOD IN connector. Or select internal and external simultaneously.

Pressing **INT** connects an internally calibrated signal to the modulator. This internal AM source defaults to a sine wave at a frequency of 1.0000 kHz.

Pressing **EXT** connects an externally calibrated signal to the modulator. You need also set the **Ext Coupling**, see “Ext Coupling” on next page.

Pressing **INT+EXT** connects both an internally calibrated signal and an external calibrated signal to the modulator simultaneously.

- Default value: INT
- Key sequence: AM > AM Source

**AM Rate**

Press this softkey menu selection to modify the internal AM modulation frequency. The active entry area displays the current value of AM rate. The allowed range is 20 Hz to 80 kHz. The minimum increment is 0.1 Hz. AM source softkey is disabled when external AM is selected.

- Default value: 1 kHz
- Key sequence: AM > AM Rate
**AM Waveform**  Press this softkey to access the softkey menu for modulating signal waveform.

- Default value: Sine
- Key sequence: AM > AM waveform

**Ext Coupling**  Pressing this softkey toggles the external modulating signal input between AC (Alternating Current) to DC (Direct Current) coupling.

Selecting AC isolates the DC component of the external input signal and will only allow the AC component to pass to the internal modulator. The amplitude of the signal will typically decrease without the DC component.

Selecting DC will allow the entire external signal, both DC and AC component. A 1.0 Vpeak + 2% input level is required.

- Default value: AC
- Key sequence: AM > EXT Coupling
Amplitude

Pressing the Amplitude hardkey will allow modification of the RF output power level. Amplitude becomes the active function and the active entry area of the instrument display will show the current value.

The calibrated power range is –127 to +13 dBm leveled output (settable to +20 dBm max). The minimum incremental value is 0.1 dB. The amplitude area of the display shows the actual RF output power, except when an amplitude sweep is in process.

- Default value: –127.0 dBm

The RF output power level may be modified using the following scales:

<table>
<thead>
<tr>
<th>Range</th>
<th>Minimum increment</th>
</tr>
</thead>
<tbody>
<tr>
<td>–127.0 to +13.0 dBm, (max. +20 dBm settable)</td>
<td>0.1 dB</td>
</tr>
<tr>
<td>–80.0 to +60.0 dBmV, (max. +67 dBmV settable)</td>
<td>0.1 dB</td>
</tr>
<tr>
<td>–20.0 to +120.0 dBμV, (max. +127 dBμV settable)</td>
<td>0.1 dB</td>
</tr>
<tr>
<td>0.0001 to 1000.0 mV, (max. 2238.8 mV settable)</td>
<td>0.1 mV</td>
</tr>
<tr>
<td>0.1 to 1000000.0 μV, (max. 2238800 μV settable)</td>
<td>0.1 μV (Ampl ≤ 999.9 μV)</td>
</tr>
<tr>
<td></td>
<td>100 μV (Ampl ≥ 1000.0 μV)</td>
</tr>
</tbody>
</table>
Arrow Keys

Pressing the left/right arrow keys allows the modification of a data digit by digit, in conjunction with rotating the knob. Pressing the Enter hardkey will confirm the data modification.

For example, to modify 2.000 000 0000 GHz to 2.000 000 0500 GHz, follow these steps:

1. Press the left/right arrow key to shift the focus to the digit.
2. Rotating the knob until the “5” position is displayed.
3. Press Enter hardkey to confirm the value modification.

Enter

The Enter hardkey has two purposes:

1. Confirming data modification. Using Enter hardkey together with arrow keys or knob to modify a data value.

2. Initiate a single sweep. For example, starting an RF single sweep by pressing Sweep > Sweep Mode > RF initiates the first run of a single RF sweep. The instrument will then stop sweeping and wait for an instruction to start another sweep. Pressing the Enter hardkey will then instruct the instrument to run another cycle of the single RF sweep.
File

Pressing the File hardkey reveals a softkey submenu for saving, recalling, or deleting a customized configuration file. For additional information, refer to “Save, Recall and Delete an Instrument State” on page 50.

- **Catalog**: Pressing this softkey selects the catalog for storing configuration files. **Local** means saving a configuration file in the instrument’s internal memory. **USB** means saving a configuration file to a USB memory stick by way of one of the USB device type connectors. Insert a external memory stick into the USB connector (device). The signal generator will then detect the USB memory stick and you may set the catalog to **USB**.
  - Default value: **Local**
  - Key sequence: File > Catalog

- **Save**
  - Enables editing a file name and saving a file
  - **Save now**
  - **Next**
    - Goes to edit next letter/number

- **Recall**
  - Recalls a file from the current catalog

- **Delete**
  - Deletes a file from the current catalog
  - **Delete now**
    - Confirms deleting
Save  Press the Save softkey to enable the instrument to save the current instrument status into a file and edit the file name. The instrument will save a maximum of 20 files in the local memory. Pressing the Preset hardkey or performing a power cycle will not affect any configuration files in local memory. See “Saving an Instrument State” on page 50 for editing a file name using Save, Save now and Next softkeys.

- Softkey sequence: File > Save

Recall  Pressing the Recall softkey will access the menu selections for recalling a customized configuration file. The files may be accessed from either local or external memory.

Files to be recalled from an external USB memory stick must be in the root directory of the USB memory stick.

- Softkey sequence: File > Recall

Delete  Press the Delete softkey to delete a configuration file that has been selected by rotating the knob. Press the Delete now to confirm the selection and file deletion.

- Softkey sequence: File > Delete

CAUTION  Do NOT press Delete now before you make sure the selected file is one not needed in the future.
FM

Press the **FM** hardkey to access the submenu selections for FM modulation configurations and settings.

<table>
<thead>
<tr>
<th><strong>FM</strong> On/Off</th>
<th>Toggles frequency modulation between on and off</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FM</strong> Deviation</td>
<td>Sets frequency modulation deviation</td>
</tr>
<tr>
<td><strong>FM</strong> Source</td>
<td>Enters frequency modulation source submenu:</td>
</tr>
<tr>
<td><strong>INT</strong></td>
<td>Selects internal FM source</td>
</tr>
<tr>
<td><strong>EXT</strong></td>
<td>Selects external FM source</td>
</tr>
<tr>
<td><strong>INT+EXT</strong></td>
<td>Selects internal and external FM source</td>
</tr>
<tr>
<td><strong>FM</strong> Rate</td>
<td>Sets frequency modulation rate</td>
</tr>
<tr>
<td><strong>FM</strong> Waveform</td>
<td>Selects frequency modulation waveform</td>
</tr>
<tr>
<td><strong>Sine</strong></td>
<td>Selects sine frequency modulation waveform</td>
</tr>
<tr>
<td><strong>EXT</strong> Coupling</td>
<td>Toggles external coupling between AC and DC</td>
</tr>
</tbody>
</table>

**FM On Off**

This softkey toggles the frequency modulation on and off. Press this softkey to turn FM on, the FM annunciator will be displayed. FM is only applied to the RF carrier only after the modulation is enabled by pressing the **Mod** hardkey. The annunciator will be displayed when Modulation has been enabled.

- Default value: **Off**
- Key sequence: **FM** > **FM** On Off
**FM Deviation**
Press this softkey to access the frequency modulation deviation control value setting. The active entry area of the instrument display will show the current FM deviation value. The allowable value range for FM is 20 Hz to 100 kHz. The minimum incremental value is 0.1 Hz.

- Default value: **20 Hz**
- Key sequence: **FM > FM Deviation**

**FM Source**
Press this softkey to reveal the submenu for Frequency modulation source selection. You may select an internal FM source, an external FM source input to MOD IN connector, or internal and external FM input sources simultaneously.

Pressing **INT** connects the internally generated, calibrated signal to the modulator. The internal FM source default is a sine wave at a frequency of 1.000 kHz.

Pressing **EXT** connects an externally calibrated signal at the MOD IN connector to the internal modulator. **EXT Coupling** must also be set, see “EXT Coupling” on next page.

Press **INT+EXT** to connect both the internally calibrated signal and an externally calibrated signal to the modulator simultaneously.

- Default value: **INT**
- Key sequence: **FM > FM Source**

**FM Rate**
Pressing this softkey allows the user to enter the frequency value desired for the internal modulation source. The active entry area displays the current FM rate. The allowable value range is 20 Hz to 80 kHz. The minimum increment is 0.1 Hz. This softkey menu selection is disabled when external FM source is selected.

- Default value: **1.0000 kHz**
- Key sequence: **FM > FM Rate**
**FM Waveform**

Pressing this softkey reveals the submenu for FM waveform selections.

- Default value: *Sine*
- Key sequence: &gt; FM Waveform

**EXT Coupling**

Pressing this softkey toggles the external modulating signal coupling input to either AC or DC coupling. A 1.0 V<sub>peak</sub> ± 2 % input level is required.

Selecting **AC** isolates the DC component in the signal allowing only the AC component to pass. The amplitude of the signal will typically decrease without the DC component.

Selecting **DC** allows both the DC and AC components of the external mod signal to enter the modulator of the signal generator.

- Default value: **AC**
- Key sequence: &gt; EXT Coupling
Frequency

Pressing the Frequency hardkey allows the modification of the RF output frequency. Frequency becomes the active function and the active entry area will display the current value.

The allowable frequency range is 9 kHz to 3 GHz. The minimum incremental value is 0.1 Hz. The frequency value will be present on the display area except when an RF swept frequency sweep is in progress.

- Default value: 3 GHz

I/Q (Option 001 only)

This softkey toggles the external I/Q modulation state between on and off. The I/Q annunciator is displayed on the screen whenever I/Q modulation is enabled.

- Default value: Off
- Key sequence: I/Q > I/Q On Off
LF Out

Pressing the LF Out hardkey reveals the submenu of softkeys to configure the internal LF (low frequency) generator.

<table>
<thead>
<tr>
<th>Softkey</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LF Out On/Off</td>
<td>Toggles the LF output between on and off</td>
</tr>
<tr>
<td>LF Out Freq</td>
<td>Sets LF frequency</td>
</tr>
<tr>
<td>LF Out Ampl</td>
<td>Sets LF output amplitude</td>
</tr>
</tbody>
</table>

**LF Out On/Off**

This softkey toggles the LF output between on and off. Once the output is on, the signal is available at the LF OUT connector. The and hardkeys do not apply when in this state.

- Default value: Off
- Key sequence: > LF On/Off

**LF Out Freq**

Press this softkey to set the frequency of the LF signal. The current LF signal frequency will be displayed. The allowed frequency range is 20 Hz to 80 kHz.

- Default value: 1.0000 kHz
- Key sequence: > LF Freq

**LF Out Ampl**

Press this softkey to set the amplitude of the LF signal. The active entry area displays the current LF signal amplitude. The allowed amplitude range is 0 to 3 Vpeak, with 1 mV minimum increment value.

- Default value: 500 mV
- Key sequence: > LF Ampl
**Mod On/Off**

Toggle this hardkey **On** to modulate the RF carrier with the active modulation. The **Mod On/Off** annunciator is always displayed to indicate whether modulation is on or off.

After pressing **Mod** hardkey, the **Mod On** annunciator will be displayed on the screen indicating the modulator is active.

- Default value: **Mod On**

**RF On/Off**

Pressing this hardkey toggles the RF out between on and off. An annunciator is always displayed indicating the RF is on or off.

Default Value: **RF Off**

**Numeric Keypad**

The front panel numeric keypad consists of the 0 to 9 digit keys, a decimal point key, and a backspace key. The backspace key has a dual function. It can backspace, or change the sign of a value to positive or negative. These keys are used any time when an active function requires a value input.

The backspace key function will change according to the operational situations outlined below:

- When modifying a previously entered value, press the backspace key to delete the entire value and replace it with a negative sign. Subsequent key pressing will change the sign between positive and negative states.
- When entering a new value, pressing the backspace key deletes the immediate left digit. If no digit remains, subsequent key pressing will change the sign between positive and negative states.
Phase Modulation

Pressing the hardkey reveals a submenu of softkeys for phase modulation configurations.

- **ΦM On/Off**: Toggles phase modulation between on and off. When phase modulation is enabled, the display annunciator is turned on. However, it is only applied to the RF carrier after the modulator is enabled by pressing the hardkey. The annunciator will then be displayed.
  
  - Default value: Off
  - Key sequence:  > ΦM On/Off

- **ΦM Deviation**: Sets phase modulation deviation. The active entry area displays current ΦM deviation value. The allowable value ranges depend on the ΦM rate:
  - 0 to 10 rad (300 Hz ≤ ΦM rate ≤ 10 kHz)
  - 0 to 5 rad (10 kHz < ΦM rate ≤ 80 kHz)
  
  - Default value: 0.000 rad
  - Key sequence:  > ΦM Deviation
**FM Source** Press this softkey to select a phase modulation source.
- Default value: **INT**
- Key sequence: \[ \text{FM} \rightarrow \Phi M \text{ Source} \]

**FM Rate** Press this softkey to modify the internal modulation frequency. The current value of FM rate will be displayed in the active entry area. The allowable value range is 300 Hz to 80 kHz. The minimum increment is 0.1 Hz. This softkey is disabled when external FM source is selected.
- Default value: **1.0000 kHz**
- Key sequence: \[ \text{FM} \rightarrow \Phi M \text{ Rate} \]

**FM Waveform** Pressing this softkey reveals a submenu of FM waveform choices.
- Default value: **Sine**
- Key sequence: \[ \text{FM} \rightarrow \Phi M \text{ Waveform} \]
Switch

Pressing this front panel switch toggles power to the signal generator between on (green LED on) and standby (orange LED on). In standby mode, the signal generator is switched off, however the instrument is still connected to the line power. The rear panel line switch and the detachable power cord are the instrument disconnecting device. The front panel standby switch, therefore, is not, and should not be used as a power switch.

CAUTION
Avoid turning off the power to the signal generator when the current state is changing either as a result of front panel operation or remote control.
Preset

Press the Preset hardkey to set the signal generator to the preset factory default conditions. Pressing this hardkey will not clear the customized configuration files that have been saved. Using the preset hardkey will give the user the advantage of knowing exactly what all instrument settings will be.

Factory Default Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Default</th>
<th>Item</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>3.000 000 0000 GHz</td>
<td>Sweep Scale</td>
<td>Linear</td>
</tr>
<tr>
<td>Amplitude</td>
<td>–127.0 dBm</td>
<td>Sweep/Point Trigger</td>
<td>Immediate</td>
</tr>
<tr>
<td>LF Out</td>
<td>Off</td>
<td>Sweep Direction</td>
<td>Up</td>
</tr>
<tr>
<td>LF Out Freq</td>
<td>1.0000 kHz</td>
<td>Trig In Polarity</td>
<td>Negative</td>
</tr>
<tr>
<td>LF Out Ampl</td>
<td>500 mV</td>
<td>Modulation</td>
<td></td>
</tr>
<tr>
<td>Mod ON/OFF</td>
<td>On</td>
<td>Modulation State</td>
<td>Off</td>
</tr>
<tr>
<td>RF ON/OFF</td>
<td>Off</td>
<td>AM Depth</td>
<td>0.0 %</td>
</tr>
<tr>
<td><strong>Sweep</strong></td>
<td></td>
<td>FM Deviation</td>
<td>0.000 rad</td>
</tr>
<tr>
<td>Sweep Mode</td>
<td>Off</td>
<td>Pulse Period</td>
<td>200 μs</td>
</tr>
<tr>
<td>RF Start</td>
<td>9.0000 kHz</td>
<td>Pulse Width</td>
<td>100 μs</td>
</tr>
<tr>
<td>RF Stop</td>
<td>3.000 000 0000 GHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amplitude Start</td>
<td>–127.0 dBm</td>
<td>Modulation Source</td>
<td>INT</td>
</tr>
<tr>
<td>Amplitude Stop</td>
<td>–126.0 dBm</td>
<td>Modulation Rate</td>
<td>1.0000 kHz</td>
</tr>
<tr>
<td>LF Start</td>
<td>20.0 Hz</td>
<td>Ext Coupling</td>
<td>AC</td>
</tr>
<tr>
<td>LF Stop</td>
<td>80.0000 kHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#Point</td>
<td>10</td>
<td>File Catalog</td>
<td>Local</td>
</tr>
<tr>
<td>Step Dwell</td>
<td>10.0 ms</td>
<td>Opt. Φ Noise</td>
<td>Normal</td>
</tr>
<tr>
<td>Sweep Repeat</td>
<td>Cont</td>
<td>Reference Source</td>
<td>Int_10 MHz</td>
</tr>
</tbody>
</table>
Pulse

Press the \( \text{Pulse} \) hardkey accesses the submenu for pulse modulation configuration settings.

- **Pulse On/Off**
  - Toggles pulse modulation between on and off
  - Enters pulse modulation source submenu:
  - Selects internal source
  - Selects external source
  - Sets pulse period
  - Sets pulse width

- **Pulse Source**
  - Press this softkey to access a menu of selections for pulse modulation sources. Select INT to connect the internally-generated, calibrated signal to the modulator. The default settings are, a 200 μs pulse period and a 100 μs pulse width. Selecting EXT connects an externally sourced input signal to the modulator through the PULSE MOD IN connector located on the rear panel of the instrument.
  - Default value: INT
  - Key sequence: \( \text{Pulse} \rightarrow \text{Pulse Source} \)
**4  Key Reference**

**Pulse Period**  
Press this softkey to modify the pulse period of the internal pulse signal. The current pulse period value will show in the active function area of the display. The allowable value range is 200 μs to 2 s, with a minimum incremental value of 1 μs. The pulse period applies only to the internal pulse signal. The **Pulse Period** softkey is disabled if an external pulse source is selected.

- Default value: 200 μs
- Key sequence: **Pulse > Pulse Period**

**Pulse Width**  
Press this softkey to modify the pulse width of the internal pulse signal. The active entry area displays the current pulse width value. The allowed value range is 100 μs to 1 s, with the minimum incremental value of 1 μs. The **Pulse Width** softkey is disabled if an external pulse source is selected.

- Default value: 100 μs
- Key sequence: **Pulse > Pulse Width**
Sweep

Press the **Sweep** accesses a menu of softkeys. The softkey menu is used to define the frequency, amplitude, and dwell time information for step sweep or list sweep.

- **Sweep State**
  - Off: Disables a sweep
  - RF: Enables radio frequency sweep mode
  - LF: Enables low frequency sweep mode
  - Ampl: Enables amplitude sweep mode
  - RF&Ampl: Enables RF&Ampl sweep mode

- **Step Scaling**
  - LOG/LIN: Toggles step scale between logarithm and linear

- **Sweep Type**
  - Step/List: Toggles sweep type between step and list

- **Sweep Repeat**
  - Single/Cont: Toggles sweep repeat between single and continuous

- **Step Sweep**
  - RF Start: Sets RF sweep start frequency
  - RF Stop: Sets RF sweep stop frequency
  - LF Start: Sets LF sweep start frequency
  - LF Stop: Sets LF sweep stop frequency
  - # Point: Sets sweep points

Continued
4 Key Reference

- **Ampl Start**: Sets sweep stop amplitude
- **Ampl Stop**: Sets sweep start amplitude
- **Step Dwell**: Sets dwell time

**List Sweep**
- **List Sweep**: Enters list sweep configuration submenu
- **Edit Item**: Edits the current item
- **Insert Row**: Inserts a new row below the current row
- **Delete Row**: Deletes the current row
- **Goto Row**: Jumps to a certain row
- **Insert Item**: Inserts a new item below the current item
- **Delete Item**: Deletes the current item
- **Recall/Save**: Recalls or saves list files (Please refer to the **file** menu)
- **Dwell Type**: Toggles dwell type between step and list
- **Preset List**: Presets the list

**Sweep Trigger**
- **Immediate**: Initiates a sweep immediately
- **Trigger Key**: Triggers a sweep with trigger key

Continued
**Sweep Mode**

Press this softkey to access a menu for selecting the sweep state and mode. Use the submenu to select an RF sweep, LF sweep, amplitude sweep, or RF&Ampl sweep. Pressing **Sweep Mode > Off** turns off the sweep. The output signal is then set according to the current **Frequency** and **Amplitude** hardkey settings.

- **Default value:** Off
- **Key sequence:** ```Sweep > Sweep Mode```

**RF**

Press the **Sweep Mode > RF** softkeys to enable an RF sweep output through the RF OUT port. The amplitude is at a constant level defined by the **Amplitude** hardkey.

**Key sequence:** ```Sweep > Sweep Mode > RF```

The signal generator produces an RF sweep signal depending on the settings for sweep trigger and point trigger as outlined in the following case conditions:
Case 1. **Sweep trigger** and **Point trigger** are both set to **Immediate (IMM)**: the signal generator initiates an RF sweep over the points immediately and automatically.

Case 2. **Sweep trigger** and **Point trigger** are both set to **Key**, pressing \( > \) **Sweep Mode > RF** arms an RF sweep. The signal generator requires the **Trigger** hardkey be pressed both to start a sweep and to sweep from point to point.

Case 3. **Sweep trigger** is set to **Key** while **Point trigger** is set to **Immediate**, pressing \( > \) **Sweep Mode > RF** arms an RF sweep. The signal generator requires the **Trigger** hardkey be pressed to start the sweep. Once started, the signal generator will sweep over the points automatically. Each sweep is begun manually by pressing the **Trigger** hardkey.

Case 4. **Sweep trigger** is set to **Immediate** while **Point trigger** is set to **Key**, pressing **Sweep > Sweep Mode > RF** initiates an RF sweep immediately. However, the signal generator requires the **Trigger** hardkey be pressed to sweep from each point to the next point.

To use the external trigger source, a TTL signal with 100 ns minimum level holding time is required. Only in the case that the sweep trigger is set to **Key** and the point trigger to **EXT**, will the sweep repeat continuously when set to either **Single** or **Cont**. This is due to using an external trigger source. The other combinations of the sweep and point triggers allows continuous sweep only.

**LF**

Pressing this softkey enables the LF sweep output through the LF OUT connector on the front panel. The amplitude is at a constant level defined by the **LF Out Ampl** softkey. This function is available only when the sweep is set to step sweep.

- Key sequence: **Sweep > Sweep Mode > LF**

**Ampl**

Pressing this softkey enables an amplitude sweep output through the RF OUT connector. The frequency is a constant value determined by the **Frequency** hardkey.

- Key sequence: **Sweep > Sweep Mode > Ampl**
Press this softkey to enable an RF & Ampl sweep output through the RF OUT connector. Both the frequency and the amplitude can be set at arbitrary values. This function is available only when the sweep type is set list sweep. See “List Sweep” on page 79.

- Key sequence: Sweep > Sweep Mode > RF&Ampl

NOTE
Similar to the RF sweep, the signal generator initiates an LF sweep or an amplitude sweep depending on the combination of settings for the sweep trigger and point trigger. See “RF” on page 75 for more information.

Press this softkey to toggle the step scale between linear or logarithmic scales for RF sweep only. The LF sweep and amplitude sweep scale is default to linear scale only.

- Default value: LIN
- Key sequence: Sweep > Step Scale

Press this softkey to toggle the sweep repetition between single and continuous sweep. In Continuous sweep mode, the signal generator automatically initiates the sweep and continuously repeats the sweep until instructed to stop. In Single sweep mode, the signal generator performs one sweep only and then waits until the user initiates another sweep using the Enter hardkey. Press the Enter hardkey each time to enable additional single sweeps. Sweep trigger and point trigger must both be set to Immediate (IMM).

- Default value: Cont
- Key sequence: Sweep > Sweep Repeat

Press this softkey to access the softkey submenu for parameter configuration of a step sweep, to include the following:

- RF/LF start and stop frequencies
- Amplitude start and stop power levels
- Number of points in a sweep and the dwell time at each point.
Key Reference

- Key sequence: > Step Sweep

**RF Start**
Press this softkey to set the RF start sweep frequency. The range is 9 kHz to 3 GHz, with a 0.1 Hz minimum increment. The start frequency must always be set to a frequency less than the stop frequency in an RF sweep.

- Default value: 9.0000 kHz
- Key sequence: > Step Sweep > RF Start

**RF Stop**
Press this softkey to set the stop sweep frequency. The range is 9 kHz to 3 GHz, with a 0.1 Hz minimum increment. The stop frequency must always be set greater than the start frequency.

- Default value: 3.000 000 0000 GHz
- Key sequence: > Step Sweep > RF Stop

**LF Start**
Press this softkey to set the LF sweep start frequency. The allowable range is 20 Hz to 80 kHz, with a 0.1 Hz minimum increment. The start frequency must always be set to a frequency less than the stop frequency.

- Default value: 20.0 Hz
- Key sequence: > Step Sweep > LF Start

**LF Stop**
Press this softkey to set the LF sweep stop frequency. The allowable range is 20 Hz to 80 kHz, with a 0.1 Hz minimum increment. The stop frequency must always be set to a greater frequency than the start frequency.

- Default value: 80.0000 kHz
- Key sequence: > Step Sweep > LF Stop

**# Points**
Press this softkey to set the number of points desired in a step sweep. The allowed range is 2 to 1001 points.

- Default value: 10
- Key sequence: > Step Sweep > # points
Ampl Start  Press this softkey to set the start amplitude in an amplitude sweep. The allowable range is –127 dBm to +13 dBm leveled, with 0.1 dB minimum increment. In an amplitude sweep, the start amplitude value must always be set lower than the stop amplitude value.

- Default value: –127.0 dBm
- Key sequence: > Step Sweep > Ampl Start

Ampl Stop  Press this softkey to set the stop amplitude in an amplitude sweep. The allowed range is –127 dBm to 13 dBm, with 0.1 dB minimum increment. The stop amplitude must always be set to a greater value than the start amplitude.

- Default value: –126.0 dBm
- Key sequence: > Step Sweep > Ampl Stop

Step Dwell  Press this softkey to set the dwell time for each point of a step sweep. The dwell time is the amount of time the sweep maintains a frequency or power for the current sweep point. The allowable range value is 10 ms to 1 s, with 0.1 ms minimum increment.

- Default value: 10.0 ms
- Key sequence: > Step Sweep > Step Dwell

List Sweep  Press this softkey to access the submenu for list sweep parameter configuration, to include:

- frequency at each point
- Amplitude power level at each point
- Number of sweep points, the dwell time at each point.

- Key sequence: > List Sweep

Edit Item  Press this softkey to edit the current highlighted item value or parameter. Use the front panel knob to select the item to edit. Use the numeric keys to input the necessary value and terminate (confirm) it with the correct unit softkey selection.

- Key sequence: > List Sweep > Edit Item
4 Key Reference

**Insert Row** Press this softkey to insert an additional (new) row below the current row.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Insert Row} \)

**Delete Row** Press this softkey to delete the current row in a list sweep data table. Note that the list sweep table must have a minimum of two rows. If there are only two rows in the current table, you cannot delete any rows.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Delete Row} \)

**Goto Row** Press this softkey to access a submenu from which you can select to jump to a specific row. Use the numeric keys to input the row number and select it with the \text{Enter} softkey. If the row to jump to is not visible as part of the current table, use the softkeys \text{Page Up} or \text{Page Down} to locate the row or table.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Goto Row} \)

**Insert Item** Press this softkey to insert a new item below the current item.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Insert Item} \)

**Delete Item** Press this softkey to delete the current highlighted item.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Delete Item} \)

**Recall/Save** Press this softkey to recall or save list files. This process is similar to the file function.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Recall/Save} \)

**Dwell Type**

**Step/List** Press this softkey to toggle the dwell type selection between step and list. When in \text{Step} mode, the dwell time for each point in the list table is equal to the dwell time value set in step sweep. When in \text{List} mode, the dwell time for each point in list sweep is set independently in the list table.

- Key sequence: \( \text{Sweep} > \text{List Sweep} > \text{Dwell Type} \)
**Preset List**
Press this softkey to preset two rows of data in the list table. The user can then edit the testing sequence data based on these two rows.

- Key sequence: `Sweep` > `List Sweep` > `Preset List`

**Sweep Trigger**
Press this softkey to access a submenu of selections for triggering a full sweep. Use this softkey to select triggering immediately, triggering by the `Trigger` hardkey, or triggering on either the positive or negative edge of an external signal supplied to the TRIGGER IN connector.

- Default value: **Immediate**
- Key sequence: `Sweep` > `Sweep Trigger`

**Point Trigger**
Press this softkey to access a submenu of selections for triggering a point-by-point sweep. Use this softkey to select the process for triggering succeeding sweep points following the dwell time of the previous point. The triggering selections immediate, automatic, triggering by pressing the `Trigger` hardkey, or external triggering. External triggering is on either the positive or negative edge of an external signal supplied to the TRIGGER IN connector.

- Default value: **Immediate**
- Key sequence: `Sweep` > `Point Trigger`

**Immediate**
This softkey is a selection in both the Sweep Trigger and the Point Trigger submenu. If both the Sweep Trigger and the Point Trigger are set to **Immediate**, the signal generator initiates a sweep covering all the points, immediately upon selecting a sweep mode (RF/LF/Ampl).

- Key sequence: `Sweep` > `Sweep Trigger` > `Immediate`
  `Sweep` > `Point Trigger` > `Immediate`
### Trigger key

This softkey is a selection in both the **Sweep Trigger** and the **Point Trigger** submenus. If both the **Sweep Trigger** and the **Point Trigger** are set to **key**, the signal generator will arm a sweep upon selecting a sweep mode. However, it requires the user to press the trigger hardkey to initiate a point-by-point sweep.

- Key sequence:
  - > Sweep Trigger > Trigger Key
  - > Point Trigger > Trigger Key

### EXT

This softkey is a selection in both the **Sweep Trigger** and the **Point Trigger** submenus. When **EXT** is selected, the external trigger source signal is switched in and will trigger a full sweep or trigger a point to point sweep. The external trigger source must be a TTL signal with 100 ns minimum level holding time.

The signal generator can also be set to trigger on the slope of the external trigger source signal. To do this, press the **Trigger In** softkey: on either the negative or the positive edge of the TTL signal.

- Key sequence:
  - > Sweep Trigger > EXT
  - > Point Trigger > EXT

### Trigger In

**Pos/Neg**

Press this softkey to toggle the slope selection of the TTL signal between positive and negative. This softkey is available only when the **EXT** is selected.

- Default value: **Neg**
- Softkey sequence: Sweep > Trigger In

### Sweep Direction

**Up /Down**

Changes the direction of sweep parameters. Choose **Up** to sweep from start frequency/amplitude to the stop frequency/amplitude. Choose **Down** to reverse the direction of sweep.

- Default value: **Up**
- Key sequence: Sweep > Sweep Direction
Trigger

Press the [Trigger] hardkey to trigger (initiate) an armed sweep or each point in a sweep. Only active when the sweep trigger or the point trigger are set to [Key].
Utility

Press the Utility hardkey to access a submenu for system configuration.

Enters the display style submenu:

- Classic White
  - Sets display style to classic white
- Modern Blue
  - Sets display style to Modern Blue
- Jade Green
  - Sets display style to Jade Green

Enters the screen saver submenu:

- On
  - Enables screen saver
- Off
  - Disables screen saver

Enters error information submenu:

- Page Up
  - Pages up the error information list
- Page Down
  - Pages down the error information list
- Clear
  - Clears the error information queue

Enters the date/time submenu:

- Date
  - Sets date information
- Time
  - Sets time information
Display Style  Press this softkey to select a display style (Classic White/Modern Blue/Jade Green).

- Default value: Modern Blue
- Key sequence: > Display style

Screen saver  Press this softkey to toggle the signal generator’s screen saver between on and off. When the screen saver is on, the screen is turned off after standing by for 15 minutes. Turn on the screen again by pressing any front panel key (except the standby switch). It will also turn back on when the generator receives a remote command.

- Default value: Off
- Key sequence: > Screen Saver

Enter the reference source submenu:

- INT-10 MHz: Selects 10 MHz internal reference source
- EXT-2 MHz: Selects 2 MHz external reference source
- EXT-5 MHz: Selects 5 MHz external reference source
- EXT-10 MHz: Selects 10 MHz external reference source

Displays system information

Enters the phase noise optimize mode menu

- Normal: Selects normal phase noise mode
- ResFM Opt.: Optimizes Residual FM

Inputs License Key to enable an option
**Error Info**  Press this softkey to access a selection menu for viewing error messages. Press **Page up/down** to view previous/next page. Press **Clear** will delete all the messages stored in the error message queue. You cannot recover message after performing this action; once the messages are deleted, they are permanently gone. When the error message queue is empty, the **ERR** annunciator is turned off.

- Key sequence: ▉ > Error Info

**Date/Time**  Pressing this softkey allows you to set the system date/time. Set system date with the **Set date** softkey. The data display format is YYYY-MM-DD. Set system time with the **Set time** softkey. The time display format is HH:MM.

- Key sequence: ▉ > Date/time

**Ref Setup**  Press this softkey to set the reference oscillator selection to either: internal 10 MHz, or external 2, 5, or 10 MHz reference oscillator.

- Default value: **INT-10 MHz**
- Key sequence: ▉ > Ref Setups

**Information**  Press this softkey to display the system information of the signal generator. The displayed information includes:

- instrument model
- instrument serial number
- current firmware version
- option status
- hardware information

- Key sequence: ▉ > Information
**Opt. \( \Phi \) Noise**  
Press this softkey to set the desired phase noise mode: *ResFM Opt.* or *Normal*. Selecting *ResFM Opt.* improves the residual FM performance, as compared to *Normal* mode.  
- Default value: *Normal*  
- Key sequence: Utility > Opt. \( \Phi \) Noise

**License Key**  
Press this softkey to enter a license key when adding or turning on an instrument option. Refer to “Enable an option” on page 25 for an example of using this function.  
- Key sequence: Utility > License Key
5 Programming Fundamentals

Remotely Operating Your N9310A 90
Getting Started with SCPI 95
IEEE 488.2 common command 103

This chapter provides information on remote instrument operation using the USB interface, PC requirements, and use of SCPI commands.
Remotely Operating Your N9310A

The signal generator provides USB (Universal Serial Bus) connections which allows remote operation with a controller computer. A controller computer can be a personal computer (PC), or a minicomputer. Some intelligent instruments can also function as controllers.

System Requirements for Remote Operation

An IBM compatible PC or controller equivalent with the following requirements are necessary to set up a remote operation environment:

**Processor:**
- 450 MHz or higher required

**Operating system:**
- Microsoft® Windows® XP, or Windows® 2000 Professional, service pack 4 or later

**Video:** SGVA (800 * 600 or greater) 256 colors

**Available memory:**
- 64 MB required

**Available disk space:** 175 MB or greater required

**Available Ports:** A compatible interface port to connect to the USB port on the signal generator.
Connecting the N9310A to a PC through the USB Port

No additional drivers are required to connect the N9310A through the USB port to a PC. Agilent IO Libraries Suite version 14.1 or later is necessary. The IO libraries suite can be found in the documentation CD that came in the shipment along with your N9310A. Or it can be downloaded from the Agilent website at:

http://www.agilent.com/find/iolib

Refer to the following steps to make the PC to signal generator connection:

1. Install IO Libraries Suite in the PC.
2. Switch on the N9310A.
3. Connect the signal generator to a PC using a USB cable as shown below:

4. Following boot up, the PC will find the N9310A as a new hardware and will prompt a message indicating “Found new hardware...”. A **Found New Hardware Wizard** is initiated immediately.
5 Programming Fundamentals

5 Select **Display a list...**
6 Windows should find **USB Test and Measurement Device**. Select it and press **Next**.

![Found New Hardware Wizard](image)

7 The wizard will guide you through the rest of installation until the correct driver is installed.

8 Open the Agilent Connection Expert in your IO Libraries Suite. The N9310A will be detected automatically. If this does not occur, press **Refresh All**.
About USB Interface

A USB connection is typically easy to setup and very cost effective. The USB specification supports a wide variety of devices that range from lower-speed devices, such as keyboards and mice to higher-speed devices, such as digital camera and intelligent instruments.

The USB interface initially offered up to 12 Mb/S. That is approximately 100 times faster than the RS-232 style serial interfaces that are used in earlier generation devices. A USB 2.0 connection is faster than both a LAN or GPIB connection.

USB Connector Types

Many USB devices come with their own built-in cable, with an “A” connection on it. If not, then the device has a socket on it that accepts a USB “B” connector. The USB standard uses “A” and “B” connectors to avoid confusion.

<table>
<thead>
<tr>
<th>Pin Map of USB Connectors</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type A (Host)</strong></td>
</tr>
<tr>
<td><img src="image" alt="Type A (Host)" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Pin caption</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VCC</td>
<td>+5 V, DC</td>
</tr>
<tr>
<td>2</td>
<td>D –</td>
<td>Data –</td>
</tr>
<tr>
<td>3</td>
<td>D +</td>
<td>Data +</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Refer to [http://www.usb.org](http://www.usb.org) for additional details.
Getting Started with SCPI

Programming with SCPI (Standard Command of Programmable Instrument) requires familiarity with the following:

- Computer programming languages, such as C, C++, and Microsoft® Visual Basic®.

- The language used to remotely control your instrument. The N9310A employs SCPI as its programming language.

The semantic requirements of your controller’s language determine how the programming commands and responses are handled in your application program.

An Introduction to the SCPI Language

SCPI is an ASCII-based instrument command language designed for test and measurement instruments, with the goal of reducing automatic test equipment (ATE) program development time.

SCPI accomplishes this goal by providing a consistent programming environment for instrument control and data usage. This consistent programming environment is achieved by the use of defined program messages, instrument responses, and data formats across all SCPI instruments.

By providing a consistent programming environment, replacing one SCPI instrument with another SCPI instrument in a system will usually require less effort than with non-SCPI instrument.

SCPI is not a standard which completely provides for interchangeable instrumentation. SCPI helps move toward interchangeability by defining instrument commands and responses, but it does not define instrument functionality, accuracy, resolution, connectors, etc.
## Common Terms used in this Book

<table>
<thead>
<tr>
<th>Terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller</td>
<td>Any computer used to communicate with an instrument. A controller can be a personal computer (PC), a minicomputer, or a plug-in card in a card cage. Some intelligent instruments can also function as controllers.</td>
</tr>
<tr>
<td>Instrument</td>
<td>Any device that implements SCPI. Most instruments are electronic measurement or stimulus devices, but this is not a requirement. Similarly, most instruments use a GPIB or RS-232 or USB interface for communication. The same concepts apply regardless of the instrument function or the type of interface used.</td>
</tr>
<tr>
<td>Command</td>
<td>An instruction. You combine commands to form messages that control instruments to complete a specified task. In general, a command consists of mnemonics (keywords), parameters and punctuation.</td>
</tr>
<tr>
<td>Query</td>
<td>A special type of command. Queries instruct the instrument to make response data available to the controller. Query keywords always end with a question mark, ? .</td>
</tr>
</tbody>
</table>

Reference material:


Command Categories

The SCPI command falls into two categories:
• Subsystem commands that simulate front panel keystrokes
• Common commands that are unique and have no front panel equivalent

Use a computer to control the signal generator (but operate the line power switch manually). Computer programming procedures for the signal generator involve selecting a programming statement and then adding the specified programming codes to that statement to achieve the desired operating conditions.

Command Syntax

Command syntax includes standard notations and statement rules.

Standard Notations

A command consists of mnemonics (keywords), parameters and punctuation. Before you start to program your signal generator, familiarize yourself with the standard notation of each of them. See the table on next page.
Many commands have both a long and a short form: use either one. (a combination of the two is not allowed). Consider the :FREQuency command for example:

- Short form :FREQ
- Long form :FREQUENCY

SCPI is not case sensitive, so fREquEncy is just as valid as FREQUENCY, but FREQ and FREQUENCY are the only valid forms of the FREQuency command.

In this documentation, upper case letters indicate the short form of the keyword. The lower case letters indicate the long form of the keyword.

<table>
<thead>
<tr>
<th>Command Mnemonics (keywords)</th>
<th>Many commands have both a long and a short form: use either one. (a combination of the two is not allowed). Consider the :FREQuency command for example:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Short form :FREQ</td>
</tr>
<tr>
<td></td>
<td>- Long form :FREQUENCY</td>
</tr>
<tr>
<td></td>
<td>SCPI is not case sensitive, so fREquEncy is just as valid as FREQUENCY, but FREQ and FREQUENCY are the only valid forms of the FREQuency command.</td>
</tr>
<tr>
<td></td>
<td>In this documentation, upper case letters indicate the short form of the keyword. The lower case letters indicate the long form of the keyword.</td>
</tr>
</tbody>
</table>

| Punctuation | A vertical bar "\|" dictates a choice of one element from a list. For example: <A>|<B> indicates that either A or B can be selected, but not both. |
|-------------|---------------------------------------------------------------------------------|
|             | - Square brackets "[ ]" indicates that the enclosed items are optional.          |
|             | - Angle brackets "< >" indicates a variable items to be entered to represent user choices. |
|             | - A question mark "\?" after a subsystem command indicates that the command is a query. The returned information, <value> varies in format according to the type of the field. |

<table>
<thead>
<tr>
<th>Separator</th>
<th>A colon &quot;:.&quot; separates keywords of different levels.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- A space separates a keyword and a parameter, as well as a parameter and a unit.</td>
</tr>
</tbody>
</table>

The colon before the root keyword is usually omitted.
Command Statement Rules Overview

Besides the standard notation of SCPI described in previous page, SCPI uses the following rules:

- Command statements read from left to right
- Use either long form or short form of keywords, but do not use both
- no separating space between the keywords, only use a colon to separate keywords of different levels
- always separating a keyword from a variable with a space
- always separating a variable from its unit with a space (if variable has a unit)

Take “:AM:DEPTh <val>” for example,

No separating space here  This is a separating space

Using Valid Commands

The following examples demonstrate valid and invalid commands.

Example 1  :FREQ:CW 900 MHz

In this example, the keyword short form is used. The command is correct and will not cause errors.
It is equivalent to front panel key access Frequency > 900 > MHz
Example 2  :AMPLITUDE:CW –85 dBm

In this example, the keyword long form is used. The command is correct and will not cause errors.
It is equivalent to front panel key access Amplitude > – 85 > dBm

NOTE
Always enter the minus symbol with English language environment settled in your PC. Minus symbol of any other language is recognized as invalid symbol.

Example 3  freq: cw 900 mhz

In this example, the keyword lowercase is used and the leading colon is omitted. The command is correct and will not cause errors. It will have the same effect as the command message that is in uppercase.

Example 4  fre: cw 900mhz

The command is incorrect and will cause errors. It uses incorrect keyword “fre”, which is not the standard short form and can not be recognized by program. Another error of this program message is that there is no space between 900 and Mhz.
Programming Fundamentals

Program and Response Messages

To understand how your instrument and controller communicate using SCPI, you must understand the concepts of program and response messages.

Program Messages

Program messages are the formatted data sent from the controller to the instrument. Conversely, response messages are formatted data sent from the instrument to the controller. Program messages contain one or more commands, and response messages contain one or more responses.

Response Messages

The controller may send commands at any time, but the instrument sends responses only when query commands is received. All query mnemonics end with a question mark. Queries return either measured values or internal instrument settings.

Forgiving Listening and Precise Talking

SCPI uses the concept of forgiving listening and precise talking outlined in IEEE 488.2.

Forgiving listening means that instruments are very flexible in accepting various command and parameter formats. For example, the signal generator accepts either

:RFOutput:STATE ON or :RFOutput:STATe 1

Precise talking means that the response format for a particular query is always the same. For example, if you query RF output state when it is on (using

:RFOutput:STATe?), the response is always 1, regardless of if you previously sent :RFOutput:STATe 1 or :RFOutput:STATE ON.

1 represents logic state 1 = ON; logic state 0 = OFF
Subsystem Command Trees

Most programming tasks involve subsystem commands that are usually specified to simulate front panel keystrokes. SCPI uses a hierarchical structure for subsystem commands similar to the file system on most computers. In SCPI, this command structure is called a command tree. It helps you to understand how the subsystem commands simulate front panel operations.

How to Use a Command Tree

In the command tree example shown below, the command closest to the left is the root command, or simply “the root”. Notice that you must follow a particular path to reach lower level sub-commands.

In this example, :LFOutput is the root keyword of the tree, FREQuency, AMPLitude and STATe are second-level keywords. If you wish to access the STATe? command, you must follow the path :LFOutput:STATe?

Example 5 Low Frequency Output Subsystem
IEEE 488.2 common command

Common commands are generally not measurement related, but are used to manage macros, status registers, synchronization, and data storage. The common commands are defined by IEEE 488.2.

All common commands begin with an asterisk. The following common commands are available in N9310A.

*RST (Reset)

Using this command resets the signal generator to factory default settings and returns the instrument to a state where it waits for a command to initiate other actions. See “Preset” on page 70 for an overview of the factory default settings of the signal generator.

*IDN? (Identification)

This is a query only command. After sending this query, the signal generator reports the following identification information:

- Manufacturer title
- Instrument module
- Instrument serial number
- Firmware version number

*CLS (Clear Status)

Using this command clears the error queue of the signal generator. There is no equivalent front panel key access.
## Subsystem Command Reference

<table>
<thead>
<tr>
<th>Subsystem</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing for Use</td>
<td>106</td>
</tr>
<tr>
<td>Frequency Subsystem</td>
<td>109</td>
</tr>
<tr>
<td>Amplitude Subsystem</td>
<td>113</td>
</tr>
<tr>
<td>Trigger Subsystem</td>
<td>115</td>
</tr>
<tr>
<td>Sweep Subsystem</td>
<td>116</td>
</tr>
<tr>
<td>AM Subsystem</td>
<td>132</td>
</tr>
<tr>
<td>FM Subsystem</td>
<td>135</td>
</tr>
<tr>
<td>Phase Modulation Subsystem</td>
<td>138</td>
</tr>
<tr>
<td>Pulse Modulation Subsystem</td>
<td>140</td>
</tr>
<tr>
<td>I/Q Modulation Subsystem</td>
<td>142</td>
</tr>
<tr>
<td>Utility Subsystem</td>
<td>143</td>
</tr>
<tr>
<td>Modulation State Subsystem</td>
<td>147</td>
</tr>
<tr>
<td>RF Output State Subsystem</td>
<td>148</td>
</tr>
<tr>
<td>LF Output Subsystem</td>
<td>149</td>
</tr>
<tr>
<td>Subsystem Command Trees</td>
<td>151</td>
</tr>
<tr>
<td>Programming Examples</td>
<td>161</td>
</tr>
</tbody>
</table>
Preparing for Use

Subsystem commands include all measurement functions and some general-purpose functions.

Subsystem Commands Overview

Each of the following subsystems is a set of commands that broadly corresponds to a functional block of the instrument.

- “Frequency Subsystem” on page 109
  Provides SCPI commands to configure frequency related items.

- “Amplitude Subsystem” on page 113
  Provides SCPI commands to configure amplitude related items.

- “Trigger Subsystem” on page 115
  Provides SCPI commands to configure a trigger event.

- “Sweep Subsystem” on page 116
  Provides SCPI commands to configure an RF step sweep, or an LF step sweep, or an amplitude step sweep. It also provides configuration commands that configure the trigger mode associated with any step sweep mode.

- “AM Subsystem” on page 132
  Provides SCPI commands to configure an AM signal.

- “FM Subsystem” on page 135
  Provides SCPI commands to configure an FM signal.

- “Phase Modulation Subsystem” on page 138
  Provides SCPI commands to configure a phase modulation signal.
• “Pulse Modulation Subsystem” on page 140
  Provides SCPI commands to configure a pulse modulation signal.

• “I/Q Modulation Subsystem” on page 142
  Provides SCPI command to configure the state of the I/Q modulation.

• “Utility Subsystem” on page 143
  Provides SCPI commands to configure the instrument system settings.

• “Modulation State Subsystem” on page 147
  Provides SCPI command to manage the modulator’s state for AM, FM, Phase modulation, and Pulse modulation.

• “RF Output State Subsystem” on page 148
  Provides a command to manage the RF output state for CW output, RF/Amplitude sweep output, and modulation output.

• “LF Output Subsystem” on page 149
  Provides SCPI commands to configure the LF output.
Conventions used in Programming

- Use "us" instead of "μs" in your coding when describing microsecond.

- Always enter a minus symbol with English language environment settled in your PC.

- The returned data of a query keeps to the following rules:
  - a boolean variable returns 1|0. (1= On, 0= Off)
  - an enumerative variable returns its short form normally. For example, :SWEep:REPeat? returns SING, indicating the current sweep repeat is in single mode.
  - a minority of enumerative variable return their specified format. For example, :SYSTem:REFerence:FREQuency? returns EXT10MHZ, indicating the current reference is set to external 10 MHz oscillator.
  - If the variable contains a parameter and a unit, with a space between them, the returned data also consists of a parameter and a unit with the best match telling the magnitude. For example, :FREQ:CW? returns a parameter with different magnitude unit:
    - “60.0000 kHz” (9 kHz ≤ Frequency < 1 MHz)
    - “450.0000000 MHz” (1 MHz ≤ Frequency < 1 GHz)
    - “1.5620000000 GHz” (Frequency ≥ 1 GHz)
Frequency Subsystem

The frequency subsystem controls the settings and parameters associated with frequency.

Continuous Wave (CW) Output Frequency

:FREQuency:CW <val> <unit>

:FREQuency:CW?

This command sets the frequency of a CW signal. The query returns the current frequency of a CW signal.

<table>
<thead>
<tr>
<th>Range</th>
<th>9 kHz to 3 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>GHz, MHz, kHz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>3.000 000 0000 GHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>frequency</td>
</tr>
</tbody>
</table>
RF Start

:FREQuency:RF:STARt <val> <unit>
:FREQuency:RF:STARt?

This command sets the start frequency in an RF sweep. The start frequency should always be lower than stop frequency in an RF sweep.
The query returns the current start frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>9 kHz to 3 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>GHz, MHz, kHz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>9.0000 kHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; RF Start</td>
</tr>
</tbody>
</table>

RF Stop

:FREQuency:RF:STOP <val> <unit>
:FREQuency:RF:STOP?

This command sets the stop frequency in an RF sweep. The stop frequency should always be set higher than the start frequency.
The query returns the current stop frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>9 kHz to 3 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>GHz, MHz, kHz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>3.000 000 0000 GHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; RF Stop</td>
</tr>
</tbody>
</table>
**LF Start**

`:FREQuency:LF:STARt <val> <unit>

`:FREQuency:LF:STARt?`

This command sets the start frequency in an LF sweep. The start frequency should always be lower than the stop frequency in an LF sweep. The query returns the current start frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>20 Hz to 80 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>kHz, Hz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>20.0 Hz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; LF Start</td>
</tr>
</tbody>
</table>

**LF Stop**

`:FREQuency:LF:STOP <val> <unit>

`:FREQuency:LF:STOP?`

This command sets the stop frequency in an LF sweep. The stop frequency should always be set higher than the start frequency. The query returns the current stop frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>20 Hz to 80 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>kHz, Hz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>80.0000 kHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; LF Stop</td>
</tr>
</tbody>
</table>
Step Scale

:FREQuency:RF:SCALe LOG|LIN

:FREQuency:RF:SCALe?

This command toggles the scale of an RF sweep between logarithmic and linear. The LOG scale is NOT applicable to amplitude sweep or LF sweep.

The query returns the current scale.

<table>
<thead>
<tr>
<th>Range</th>
<th>LOG, LIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>LIN</td>
</tr>
<tr>
<td>Returned data</td>
<td>LOG, LIN</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Scale</td>
</tr>
</tbody>
</table>
Amplitude Subsystem

The amplitude subsystem controls the settings and parameters associated with amplitude.

Continuous Wave Output Amplitude

:AMPLitude:CW <val> <unit>

:AMPLitude:CW?

This command sets the amplitude of CW output.

The query returns the current amplitude of CW output.

<table>
<thead>
<tr>
<th>Range and unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-127 to +13 dBm, (+20 dBm settable)</td>
<td></td>
</tr>
<tr>
<td>-80 to +60 dBmV, (+67 dBmV settable)</td>
<td></td>
</tr>
<tr>
<td>-20 to +120 dBμV, (+127 dBμV settable)</td>
<td></td>
</tr>
<tr>
<td>0.0001 to 1000 mV, (2238.8 mV settable)</td>
<td></td>
</tr>
<tr>
<td>0.1 to 1 000 000 μV, (2238800 μV settable)</td>
<td></td>
</tr>
</tbody>
</table>

Minimum increment

- 0.1 dB (When using dBm/dBmV/dBμV)
- 0.1 mV (When using mV)
- 0.1 μV (Ampl ≤ 999.9 μV)
- 100 μV (Ampl ≥ 1000 μV)

*RST value

-127.0 dBm

Returned data format

<val> <unit>

Front panel access

Amplitude
Amplitude Start

:AMPLitude:STARt <val> <unit>
:AMPLitude:STARt?

This command sets the start amplitude in an amplitude sweep. The start amplitude should always be lower than the stop amplitude in an amplitude sweep.
The query returns the current start amplitude.

<table>
<thead>
<tr>
<th>Range</th>
<th>-127 to +13 dBm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>dBm</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 dBm</td>
</tr>
<tr>
<td>^RST value</td>
<td>-127.0 dBm</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; Ampl Start</td>
</tr>
</tbody>
</table>

Amplitude Stop

:AMPLitude:STOP <val> <unit>
:AMPLitude:STOP?

This command sets the stop amplitude in an amplitude sweep. The stop amplitude should always be higher than the start amplitude.
The query returns the current stop amplitude.

<table>
<thead>
<tr>
<th>Range</th>
<th>-127 to +13 dBm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>dBm</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 dB</td>
</tr>
<tr>
<td>^RST value</td>
<td>13.0 dBm</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; Ampl Stop</td>
</tr>
</tbody>
</table>
The trigger subsystem controls the settings and parameters associated with triggering a sweep.

### Immediate Trigger

:TRIGger:IMMediate

This command has no effect unless sweep is armed. It has an equivalent function to the Trigger hardkey in activating an armed sweep.

*There is no query for this command.*

Front panel access: Trigger

### Single Sweep

:TRIGger:SSWP

This command initiates a single RF/LF/Amplitude sweep when the following conditions are met:

- Sweep and point trigger are both set to IMMEDIATE
- Sweep repeat is set to SINGLE
- An RF/LF/Amplitude sweep is enabled and first free run of the sweep is complete

*There is no query for this command.*

Front panel access: Enter
Sweep Subsystem

The sweep subsystem controls the settings and parameters associated with an RF/LF/Amplitude/RF&Ampl sweep.

**NOTE**
To make an RF/amplitude sweep available at the RF OUT connector, make sure you enable RF output. See “RF Output State Subsystem” on page 148

**RF Sweep State**

```
:SWEep:RF:STATe ON|OFF|1|0
:SWEep:RF:STATe?
```

This command initiates the signal generator to sweep in a different manner, according to the sweep trigger or point trigger settings:

- If the sweep trigger and point trigger are both set to **IMMediate**, sending this command below initiates an RF sweep immediately:
  
  “:SWEep:RF:STATe ON”

- If either the sweep trigger or point trigger is set to **KEY**, sending the commands “:SWEep:RF:STATe ON” arms an RF sweep. Sending command “:TRIGger IMMediate” initiates
  the RF sweep.

- If either the sweep trigger or point trigger is set to **EXT**, sending the commands “:SWEep:RF:STATe ON” arms an RF sweep. No further command is needed to initiate the RF sweep, but a proper external signal should be input into the signal generator.

The query returns a current RF sweep state.

---

<table>
<thead>
<tr>
<th>Range</th>
<th>On (1), OFF (0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweepe &gt; Sweep Mode &gt; RF/Off</td>
</tr>
</tbody>
</table>
**LF Sweep State**

`:SWEep:LF:STATe ON|OFF|1|0

`:SWEep:LF:STATe?

This command initiates your signal generator to sweep in a different manner, according to the sweep trigger or point trigger settings:

- If the sweep trigger and point trigger are both set to **IMMediate**, sending the following command initiates an LF sweep immediately: 
  
  "`:SWEep:LF:STATe ON""

- If either the sweep trigger or point trigger is set to **KEY**, sending the command "`:SWEep:LF:STATe ON"" arms an LF sweep: 
  Sending command "`:TRIGger IMMEDIATE"" initiates the LF sweep.

- If either the sweep trigger or point trigger is set to **EXT**, sending the commands "`:SWEep:LF:STATe ON"" arms an LF sweep. No further command is needed to initiate the LF sweep, but a proper external signal should be input into the signal generator.

The query returns the current LF sweep state.

<table>
<thead>
<tr>
<th>Range</th>
<th>On (1), OFF (0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Mode &gt; LF Sweep &gt; Sweep Mode &gt; Off (abort an on-going LF sweep)</td>
</tr>
</tbody>
</table>
Amplitude Sweep State

:SWEep:AMPLitude:STATe ON|OFF|1|0
:SWEep:AMPLitude:STATe?

This command initiates your signal generator to sweep in a different manner, according to the sweep trigger or point trigger settings:

- If the sweep trigger and point trigger are set to IMMediate, sending the command “:SWEep:AMPLitude:STATe ON” initiates an immediate amplitude sweep.
- If either the sweep trigger or point trigger is set to KEY, sending the command “:SWEep:AMPLitude:STATe ON” arms an amplitude sweep. Sending command “:TRIGger IMMEDIATE” initiates the amplitude sweep.
- If either the sweep trigger or point trigger is set to EXT, sending the commands “:SWEep:AMPLitude:STATe ON” arms an amplitude sweep. No further command is needed to initiate the amplitude sweep, but a proper external signal should be input into the signal generator.

The query returns the current amplitude sweep state.

<table>
<thead>
<tr>
<th>Range</th>
<th>On (1), OFF (0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Mode &gt; Amplitude</td>
</tr>
<tr>
<td></td>
<td>Sweep &gt; Sweep Mode &gt; Off</td>
</tr>
</tbody>
</table>
RF Start

:SWEep:RF:STARt <val> <unit>

:SWEep:RF:STARt?

This command sets the start frequency in an RF sweep. The start frequency should always be lower than the stop frequency in an RF sweep.

The query returns the current start frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>9 kHz to 3 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>GHz, MHz, kHz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>9.0000 kHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; RF Start</td>
</tr>
</tbody>
</table>

RF Stop

:SWEep:RF:STOP <val> <unit>

:SWEep:RF:STOP?

This command sets the stop frequency in an RF sweep. The stop frequency should always be set higher than the start frequency.

The query returns the current stop frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>9 kHz to 3 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>GHz, MHz, kHz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>3.000 000 0000 GHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; RF Stop</td>
</tr>
</tbody>
</table>
LF Start

:SWEep:LF:STARt <val> <unit>
:SWEep:LF:STARt?

This command sets the start frequency in an LF sweep. The start frequency should always be lower than the stop frequency in an LF sweep.
The query returns the current start frequency.

Range
Valid unit
Minimum increment
*RST value
Returned data format
Front panel access

20 Hz to 80 kHz
kHz, Hz
0.1 Hz
20.0 Hz
<val> <unit>
Sweep > Step Sweep > LF Start

LF Stop

:SWEep:LF:STOP <val> <unit>
:SWEep:LF:STOP?

This command sets the stop frequency in an LF sweep. The stop frequency should always be set higher than the start frequency.
The query returns the current stop frequency.

Range
Valid unit
Minimum increment
*RST value
Returned data format
Front panel access

20 Hz to 80 kHz
kHz, Hz
0.1 Hz
80.0000 kHz
<val> <unit>
Sweep > Step Sweep > LF Stop
Amplitude Start

:SWEep:AMPLitude:STARt <val> <unit>
:SWEep:AMPLitude:STARt?

This command sets the start amplitude in an amplitude sweep. The start amplitude should always be lower than the stop amplitude in an amplitude sweep. The query returns the current start amplitude.

| Range and unit | -127 to +13 dBm |
| Valid unit    | dBm             |
| Minimum increment | 0.1 dB         |
| *RST value   | -127.0 dBm      |
| Returned data format | <val> <unit>    |
| Front panel access | Sweep > Step Sweep > Ampl Start |

Amplitude Stop

:SWEep:AMPLitude:STOP <val> <unit>
:SWEep:AMPLitude:STOP?

This command sets the stop amplitude in an amplitude sweep. The stop amplitude should always be higher than the start amplitude. The query returns the current stop amplitude.

| Range and unit | -127 to +13 dBm |
| Valid unit    | dBm             |
| Minimum increment | 0.1 dB         |
| *RST value   | 13.0 dBm        |
| Returned data format | <val> <unit> |
| Front panel access | Sweep > Step Sweep > Ampl Stop |
### Step Points

**:SWEep:STEP:POINts <val>**

**:SWEep:STEP:POINts?**

This command defines the number of points in a step sweep. A step sweep must always have a minimum of two points and can be configured to have as many as 1001 points.

The query returns the current number of points.

<table>
<thead>
<tr>
<th>Range</th>
<th>2 to 1001</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>10</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; # Points</td>
</tr>
</tbody>
</table>

### Step Dwell

**:SWEep:STEP:DWELL <val> <unit>**

**:SWEep:STEP:DWELL?**

This command sets the dwell time for each point in a sweep. The query returns the current dwell time.

<table>
<thead>
<tr>
<th>Range</th>
<th>10 ms to 1s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>s, ms</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 ms</td>
</tr>
<tr>
<td>*RST value</td>
<td>10.0 ms</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Step Sweep &gt; Step Dwell</td>
</tr>
</tbody>
</table>
### Sweep Type

:SWEp:TYPE STEP|LIST
:SWEp:TYPE?

This command toggles the sweep type between step and list. The query returns the current sweep type.

<table>
<thead>
<tr>
<th>Range</th>
<th>STEP/LIST</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>STEP</td>
</tr>
<tr>
<td>Returned data</td>
<td>STEP, LIST</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Type</td>
</tr>
</tbody>
</table>

### List Power State

:LIST:POWer:STATe ON|OFF|1|0
:LIST:POWer:STATe?

This command toggles the RF&Ampl list between on and off. The query returns the current list power state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Mode &gt; RF&amp;Ampl</td>
</tr>
<tr>
<td></td>
<td>Sweep &gt; Sweep Mode &gt; Off</td>
</tr>
</tbody>
</table>
### List Dwell

:LIST:DWELL <val> <unit>

:LIST:DWELL?

This command sets the dwell time for the current list sweep point.
The query returns the current list sweep point's dwell time.

<table>
<thead>
<tr>
<th>Range</th>
<th>10 ms to 1s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>s, ms</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 ms</td>
</tr>
<tr>
<td>*RST value</td>
<td>10.0 ms</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; List Sweep &gt; Edit Item</td>
</tr>
</tbody>
</table>

### List RF

:LIST:RF <val> <unit>

:LIST:RF?

This command sets the frequency value for the current list sweep point.
The query returns the current list sweep point's frequency value.

<table>
<thead>
<tr>
<th>Range</th>
<th>9 kHz to 3 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>GHz, MHz, kHz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>9.0000 kHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; List Sweep &gt; Edit Item</td>
</tr>
</tbody>
</table>
List Amplitude

:LIST:Amplitude <val> <unit>
:LIST:Amplitude?

This command sets the amplitude value for the current list sweep point.
The query returns the current list sweep point’s amplitude value.

<table>
<thead>
<tr>
<th>Range and unit</th>
<th>-127 to +13 dBm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>dBm</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>0.1 dB</td>
</tr>
<tr>
<td>*RST value</td>
<td>13.0 dBm</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; List Sweep &gt; Edit Item</td>
</tr>
</tbody>
</table>

List Dwell Points

:LIST:DWELL:POINts?

The query returns the number of dwell points in the current list sweep file.

List RF Points

:LIST:RF:POINts?

The query returns the number of frequency points in the current list sweep file.
List Amplitude Points

:LIST:AMPLitude:POINts?

The query returns the number of amplitude points in the current list sweep file.

List Row Goto

:LIST:ROW:GOTO <val>
:LIST:ROW:GOTO?

This command sets the list to the specified row. The query returns the current row number.

<table>
<thead>
<tr>
<th>Range</th>
<th>2 to 1001</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>10</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; List Sweep &gt; Goto Row</td>
</tr>
</tbody>
</table>

List Row Insert

:LIST:ROW:INSert <val>

This command inserts a new row below the specified row.

<table>
<thead>
<tr>
<th>Range</th>
<th>2 to 1001</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>10</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; List Sweep &gt; Goto Row</td>
</tr>
<tr>
<td></td>
<td>Sweep &gt; List Sweep &gt; Insert Row</td>
</tr>
</tbody>
</table>
List Row Delete

:LIST:ROW:DELe te <val>
This command deletes the specified row in the list table.

<table>
<thead>
<tr>
<th>Range</th>
<th>2 to 1001</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>10</td>
</tr>
</tbody>
</table>
| Front panel access | Sweep > List Sweep > Goto Row  
Sweep > List Sweep > Delete Row |

List Rows

:LIST:ROWS?
This query returns the number of the current row in the list table.

<table>
<thead>
<tr>
<th>Range</th>
<th>2 to 1001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt;</td>
</tr>
</tbody>
</table>

List Preset

:LIST:PRESet
This command replaces the current list sweep data with a factory-defined file consisting of two rows.

| Front panel access | Sweep > List Sweep > Preset |
List Dwell Type

:LIST:DWELL:TYPE  STEP|LIST
:LIST:DWELL:TYPE?

This command toggles the dwell time type between step and list.
The query returns the current list dwell type.

<table>
<thead>
<tr>
<th>Range</th>
<th>STEP/LIST</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>STEP</td>
</tr>
<tr>
<td>Returned data</td>
<td>STEP, LIST</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; List Sweep &gt; Dwell Type</td>
</tr>
</tbody>
</table>

Sweep Repeat

:SWEep:REPeat  SINGle|CONTinuous
:SWEep:REPeat?

This command toggles the sweep repeat between single and continuous.
The query returns the current sweep repeat state.

<table>
<thead>
<tr>
<th>Range</th>
<th>SINGle/CONTinuous</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>CONTinuous</td>
</tr>
<tr>
<td>Returned data</td>
<td>SING, CONT</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Repeat</td>
</tr>
</tbody>
</table>
Sweep Trigger

:SWEep:STRG IMMEDIATE|KEY|EXT
:SWEep:STRG?

This command sets the sweep trigger mode to one of the following choices:

- **IMMediate** - Selecting this mode immediately triggers signal generator to sweep from the first point to the final point in a sweep sequence automatically.
- **KEY** - Selecting this mode arms a sweep. The armed sweep will be initiated by sending the “TRIGger:IMMediate” command.
- **EXT** - Selecting this mode enables an external trigger source to initiate an armed sweep.

The query returns the current sweep trigger mode.

<table>
<thead>
<tr>
<th>Range</th>
<th>IMMEDIATE, KEY, EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>IMMEDIATE</td>
</tr>
<tr>
<td>Returned data</td>
<td>IMM, KEY, EXT</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Trigger</td>
</tr>
</tbody>
</table>

External Sweep Trigger Slope

:SWEep:STRG:SLOPe EXTN|EXTP
:SWEep:STRG:SLOPe?

This command toggles the slope of external trigger source between negative (EXTN) and positive (EXTP). This command is valid only when an external trigger source is properly connected and enabled.

If you have select EXT (an external trigger source), the query returns the current slope of the external trigger
source. If you have NOT select EXT or you preset the signal generator, the query returns “NA”.

<table>
<thead>
<tr>
<th>Range</th>
<th>EXTN, EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>NA</td>
</tr>
<tr>
<td>Returned data</td>
<td>EXTN, EXT, NA</td>
</tr>
</tbody>
</table>

Front panel access Sweep > Sweep Trigger > Trigger In Neg/Pos

**Point Trigger**

:SWEep:PTRG IMMEDIATE|KEY|EXT
:SWEep:PTRG?

This command sets the point trigger mode to one of the following items:
- **IMMEDIATE** - immediately initiates a sweep.
- **KEY** - arms a sweep and requires you to send the command “TRIGger:IMMEDIATE”
- **EXT** - enables an external trigger source to initiate each point in a sweep.

The query returns the current sweep trigger mode.

<table>
<thead>
<tr>
<th>Range</th>
<th>IMMEDIATE, KEY, EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>IMMEDIATE</td>
</tr>
<tr>
<td>Returned data</td>
<td>IMM, KEY, EXT</td>
</tr>
</tbody>
</table>

Front panel access Sweep > Point Trigger
External Point Trigger Slope

:SWEep:PTRG:SLOPe EXTN|EXTP
:SWEep:PTRG:SLOPe?

This command toggles the slope of external trigger source between negative (EXTN) and positive (EXTP). This command is valid only when an external trigger source is properly connected and enabled.

If you have selected EXT (an external trigger source), the query returns the current slope of the external trigger source. If you have NOT selected EXT or you preset the signal generator, the query returns “NA”.

<table>
<thead>
<tr>
<th>Range</th>
<th>EXTN, EXTP</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>NA</td>
</tr>
<tr>
<td>Returned data</td>
<td>EXTN, EXTP, NA</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Point Trigger &gt; Trigger In Neg/Pos</td>
</tr>
</tbody>
</table>

Sweep Direction

:SWEep:DIRection UP|DOWN
:SWEep:DIRection?

This command sets the sweep direction of an RF, LF or an amplitude sweep to either of the following choices:

- **UP** - sweeps from start point to stop point
- **Down** - sweeps from stop point to start point

The query returns the current sweep direction.

<table>
<thead>
<tr>
<th>Range</th>
<th>UP, DOWN</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>UP</td>
</tr>
<tr>
<td>Returned data</td>
<td>UP, DOWN</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Sweep &gt; Sweep Direction</td>
</tr>
</tbody>
</table>
**AM Subsystem**

The AM subsystem controls the settings and parameters associated with amplitude modulated signal.

**AM State**

:AM:STATe ON|OFF|1|0

:AM:STATe?

This command toggles the AM state between ON and OFF. However, applying an amplitude modulation to the RF carrier requires you also set MOD on.

See “Modulation State Subsystem” on page 147.

The query returns the current AM state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>AM &gt; AM On/Off</td>
</tr>
</tbody>
</table>


AM Depth

:AM:DEPTh <val>
:AM:DEPTh?

This command sets the amplitude modulation depth.
The query returns the current AM depth.

+ Range                              | 0 to 100   |
+-------------------------------------|------------|
+ Minimum increment                   | 0.1        |
+ *RST value                          | 0.0 %      |
+ Returned data                       | <val>      |
+ Front panel access                  | AM > AM Depth|

AM Rate

:AM:RATE <val> <unit>
:AM:RATE?

This command sets the frequency of the internal AM source.
The query returns the current frequency of the internal AM source.

+ Range                              | 20 Hz to 80 kHz |
+-------------------------------------|-----------------|
+ Minimum increment                   | 0.1 Hz          |
+ *RST value                          | 1.0000 kHz      |
+ Returned data format                | <val> <unit>    |
+ Front panel access                  | AM > AM Rate    |
**AM Source**

:AM:SOURce INT|EXT|INT+EXT

:AM:SOURce?

This command sets the AM source to one of the three choices: internal source, external source or combined internal and external source.

The query returns the current AM source.

<table>
<thead>
<tr>
<th>Range</th>
<th>INT, EXT, INT+EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>INT</td>
</tr>
<tr>
<td>Returned data</td>
<td>INT, EXT, INT+EXT</td>
</tr>
<tr>
<td>Front panel access</td>
<td>AM &gt; AM Source</td>
</tr>
</tbody>
</table>

**AM External Coupling**

:AM:EXTCoupling AC|DC

:AM:EXTCoupling?

This command sets the coupling for the external AM source. The choice is either AC or DC coupling. AC coupling passes only AC signal components. DC coupling passes both the AC and DC signal components. This command is effective only when an external AM source is connected and enabled.

The query returns the current external coupling state.

<table>
<thead>
<tr>
<th>Range</th>
<th>AC, DC</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>AC</td>
</tr>
<tr>
<td>Returned data</td>
<td>AC, DC</td>
</tr>
<tr>
<td>Front panel access</td>
<td>AM &gt; EXT Coupling</td>
</tr>
</tbody>
</table>
FM Subsystem

The FM subsystem controls the settings and parameters associated with frequency modulated signal.

**FM State**

:FM:STATe ON|OFF|1|0

:FM:STATe?

This command toggles the FM state between ON and OFF. However, applying a frequency modulation to the RF carrier requires you also set MOD on.

See “Modulation State Subsystem” on page 147

The query returns the current FM state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>FM &gt; FM On/Off</td>
</tr>
</tbody>
</table>
**FM Deviation**

:FM:DEViation <val> <unit>

:FM:DEViation?

This command sets the FM deviation.

The query returns the current FM deviation.

<table>
<thead>
<tr>
<th>Range</th>
<th>20 Hz to 100 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>kHz, Hz</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>20 Hz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td><strong>FM &gt; FM Deviation</strong></td>
</tr>
</tbody>
</table>

**FM Rate**

:FM:RATE <val> <unit>

:FM:RATE?

This command sets the frequency of the internal FM source.

The query returns the current frequency of the internal FM source.

<table>
<thead>
<tr>
<th>Range</th>
<th>20 Hz to 80 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum increment</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>1.0000 kHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td><strong>FM &gt; FM Rate</strong></td>
</tr>
</tbody>
</table>
**FM Source**

:`FM:SOURce INT|EXT|INT+EXT`

:`FM:SOURce?`

This command sets the FM source to one of the three choices: internal source, external source or combined internal and external source.

The query returns the current FM source.

- **Range**: INT, EXT, INT+EXT
- **RST value**: INT
- **Returned data format**: INT, EXT, INT+EXT
- **Front panel access**: FM > FM Source

**FM External Coupling**

:`FM:EXTCoupling AC|DC`

:`FM:EXTCoupling?`

This command sets the coupling for the external FM source. The choice is either AC or DC coupling. AC coupling passes only AC signal components. DC coupling passes both the AC and DC signal components.

This command is effective only when an external FM source is connected and enabled.

The query returns the current external coupling state.

- **Range**: AC, DC
- **RST value**: AC
- **Returned data**: AC, DC
- **Front panel access**: FM > EXT Coupling
Phase Modulation Subsystem

The phase modulation (ΦM) subsystem controls the settings and parameters associated with phase modulated signal.

ΦM State

:PM:STATe ON|OFF|1|0

:PM:STATe?

This command toggles the ΦM state between ON and OFF. However, applying a phase modulation to the RF carrier requires you also set MOD on. See “Modulation State Subsystem” on page 147.

The query returns the current ΦM state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1)/OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>ΦM &gt; ΦM On/Off</td>
</tr>
</tbody>
</table>

**FM Deviation**

:PM:DEViation <val> <unit>
:PM:DEViation?

This command sets the FM deviation.

Choices for the variables <val> depend on FM rate.

The query returns the current FM deviation.

| Range | 0 to 10 rad (300 Hz ≤ FM rate ≤ 10 kHz)  
|       | 0 to 5 rad (10 kHz < FM rate ≤ 20 kHz)  
| Valid unit | rad  
| Minimum increment | 0.001 rad  
| *RST value | 0.000 rad  
| Returned data format | <val> <unit>  
| Front panel access | FM > FM Deviation |

**FM Rate**

:PM:RATE <val> <unit>
:PM:RATE?

This command sets the frequency of the internal FM source.

The query returns the current frequency of the internal FM source.

| Range | 300 Hz to 80 kHz  
| Minimum increment | 0.1 Hz  
| *RST value | 1.0000 kHz  
| Returned data format | <val> <unit>  
| Front panel access | FM > FM Rate |
Pulse Modulation Subsystem

The phase modulation (ΦM) subsystem controls the settings and parameters associated with phase modulated signal.

Pulse Modulation State

:PULM:STATe ON|OFF|1|0
:PULM:STATe?
This command toggles the pulse modulation state between ON and OFF. The query returns the current pulse modulation state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Pulse &gt; Pulse On/Off</td>
</tr>
</tbody>
</table>

Pulse Source

:PULM:SOURce INT|EXT
:PULM:SOURce?
This command sets the pulse source to either internal or external source. The query returns the current pulse modulation source.

<table>
<thead>
<tr>
<th>Range</th>
<th>INT, EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>INT</td>
</tr>
<tr>
<td>Returned data</td>
<td>INT, EXT</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Pulse &gt; Pulse Source</td>
</tr>
</tbody>
</table>
Pulse Period

:PULM:WIDTh <val> <unit>
:PULM:WIDTh?

This command sets the pulse period of the internally generated pulse modulation signal. The query returns the current pulse period of the internal pulse source.

<table>
<thead>
<tr>
<th>Range</th>
<th>200 μs to 2s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>s, ms, us</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>1 us</td>
</tr>
<tr>
<td>*RST value</td>
<td>200 us</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Pulse &gt; Pulse Period</td>
</tr>
</tbody>
</table>

Pulse Width

:PULM:PERiod <val> <unit>
:PULM:PERiod?

This command sets the pulse width of the internally generated pulse modulation signal. The query returns the current pulse width of the internal pulse source.

<table>
<thead>
<tr>
<th>Range</th>
<th>100 us to 1s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>s, ms, us</td>
</tr>
<tr>
<td>Minimum increment</td>
<td>1 us</td>
</tr>
<tr>
<td>*RST value</td>
<td>100 us</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Pulse &gt; Pulse Width</td>
</tr>
</tbody>
</table>
I/Q Modulation Subsystem

The I/Q modulation subsystem controls I/Q modulation.

Enable I/Q Modulation

:I/Q:STATe ON|OFF|1|0
:I/Q:STATe?

This command toggles the externally generated I/Q modulation state between ON and OFF.

The external I/Q signal must meet the following restrictions, before you enable the I/Q modulation:

- input impedance 50 Ω
- VSWR < 1.5
- Full scale input voltage < 0.5 V_{rms}

The query returns the current state of I/Q modulation.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>I/Q &gt; I/Q On/Off</td>
</tr>
</tbody>
</table>
Utility Subsystem

The commands of the utility subsystem control the settings and parameters associated with the signal generator’s system configurations.

Display Style

:SYStem:DISPlay WHITE|BLUE|GREEN

:SYStem:DISPlay?

This command sets the display style to any of the following three choices: classic white, modern blue or jade green. The query returns the current display style in use.

<table>
<thead>
<tr>
<th>Range</th>
<th>WHITE, BLUE, GREEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>BLUE</td>
</tr>
<tr>
<td>Returned data</td>
<td>WHITE, BLUE, GREEN</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Utility &gt; Display Style</td>
</tr>
</tbody>
</table>

Error Messages

:SYStem:ERRor?

This is a query only command.

It returns the a decimal value that indicates the error message code number. To interpret the error code number, please refer to “Instrument Messages” on page 173.
Screen Saver

:SYSTem:SSAVer ON|OFF|1|0

:SYSTem:SSAVer?

This command toggles the screen saver between On and Off. If you set the screen saver On, the signal generator turns off its screen after standing by for 15 minutes. Pressing Local hardkey turns on screen but also returns the signal generator to Local Control.

The query returns the current screen saver state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Utility &gt; Screen Saver</td>
</tr>
</tbody>
</table>

System Date

:SYSTem:DATE <year><month><day>

:SYSTem:DATE?

This command sets the date in the signal generator. Do NOT put a space or comma between the variables <year><month><day>.

The query returns the current date in the signal generator.

<table>
<thead>
<tr>
<th>Range</th>
<th>Year: 1980 to 2030, four-digit numeric type (YYYY)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Month: 01 to 12, two-digit numeric type (MM)</td>
</tr>
<tr>
<td></td>
<td>Day: 01 to 31, two-digit numeric type (DD)</td>
</tr>
<tr>
<td>Returned data</td>
<td>&lt;year&gt;&lt;month&gt;&lt;day&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Utility &gt; Date/Time &gt; Set Date</td>
</tr>
</tbody>
</table>
System Time

:SYSTem:TIME <hour><minute>
:SYSTem:TIME?

This command sets time on the signal generator. Do NOT put a space or comma between the variables <hour><minute>. The query returns the current time in the signal generator.

| Range | • Hour: 00 to 23, two-digit numeric type numeric (HH)
|       | • Minute: 0 to 59, two-digit numeric type numeric (MM) |

| Returned data | <hour><minute><second> |

Front panel access Utility > Date/Time > Set Time

Reference Oscillator Sources

:SYSTem:REference:FREQuency
INT10MHZ | EXT2MHZ | EXT5MHZ | EXT10MHZ
:SYSTem:REference:FREQuency?

This command sets the reference oscillator to any of the four choices:

• internal 10 MHz reference oscillator
• external 2 MHz reference oscillator
• external 5 MHz reference oscillator
• external 10 MHz reference oscillator

The query returns the current reference source.

| Range | INT10MHZ, EXT2MHZ, EXT5MHZ, EXT10MHZ |
| *RST value | INT10MHZ |
| Returned data | INT10MHZ, EXT2MHZ, EXT5MHZ, EXT10MHZ |

Front panel access Utility > Ref Setsups
Phase Noise Mode

:SYSTem:PNMD NORMAL\| RESFM

:SYSTem:PNMD?

This command sets the phase noise mode to either normal mode or optimized residual FM mode (RESFM).

<table>
<thead>
<tr>
<th>Range</th>
<th>NORMAL, RESFM</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>NORMAL</td>
</tr>
<tr>
<td>Returned data</td>
<td>NORMAL, RESFM</td>
</tr>
<tr>
<td>Front panel access</td>
<td>Utility &gt; Opt. Φ Noise</td>
</tr>
</tbody>
</table>


Modulation State Subsystem

:MOD:STATe ON|OFF|1|0

:MOD:STATe?

This command enables or disables the modulator. The query returns the current modulator state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>ON</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>MOD On/Off</td>
</tr>
</tbody>
</table>
RF Output State Subsystem

:RFOutput:STATe ON|OFF|1|0

:RFOutput:STATe?

This command enables or disables the RF output. The query returns the current RF output state.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>RF On/Off</td>
</tr>
</tbody>
</table>
LF Output Subsystem

The low frequency (LF) subsystem controls the settings and parameters of an LF output signal.

**LF Output State**

:LFOutput:STATE ON|OFF|1|0

:LFOutput:STATE?

This command enables or disables the LF signal output. The query returns the current state of LF output signal.

<table>
<thead>
<tr>
<th>Range</th>
<th>ON(1), OFF(0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST value</td>
<td>OFF</td>
</tr>
<tr>
<td>Returned data</td>
<td>1, 0</td>
</tr>
<tr>
<td>Front panel access</td>
<td>LF Out &gt; LF Out On/Off</td>
</tr>
</tbody>
</table>
LF Output Frequency

:LFOutput:FREQuency <val> <unit>
:LFOutput:FREQuency?

This command sets the LF output frequency. The query returns the current LF signal frequency.

<table>
<thead>
<tr>
<th>Range</th>
<th>20 Hz to 80 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>kHz, Hz</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>*RST value</td>
<td>1.0000 kHz</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>LF Out &gt; LF Freq</td>
</tr>
</tbody>
</table>

LF Output Amplitude

:LFOutput:AMPLitude <val> <unit>
:LFOutput:AMPLitude?

This command sets the LF output amplitude. The query returns the current LF output amplitude.

<table>
<thead>
<tr>
<th>Range</th>
<th>0 to 3 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid unit</td>
<td>V, mV</td>
</tr>
<tr>
<td>Resolution</td>
<td>1 mV</td>
</tr>
<tr>
<td>*RST value</td>
<td>500 mV</td>
</tr>
<tr>
<td>Returned data format</td>
<td>&lt;val&gt; &lt;unit&gt;</td>
</tr>
<tr>
<td>Front panel access</td>
<td>LF Out &gt; LF Ampl</td>
</tr>
</tbody>
</table>
Subsystem Command Trees

Subsystem command trees help you to understand command syntax and the hierarchal structure of each command in a subsystem.

Symbols used in Command Trees

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Caption</th>
<th>Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>Colon</td>
<td>Separates different level keywords</td>
</tr>
<tr>
<td>sp</td>
<td>Space</td>
<td>Separates parameters from keywords and also separates parameters from their units</td>
</tr>
<tr>
<td>value</td>
<td>Numeric parameter</td>
<td>Requires you to customize an exact number for the variable</td>
</tr>
<tr>
<td>A</td>
<td>B</td>
<td>Enumerative or Boolean parameter</td>
</tr>
<tr>
<td>unit</td>
<td>Unit</td>
<td>use along with numeric parameter</td>
</tr>
<tr>
<td>RF</td>
<td>Key word</td>
<td>mnemonics of different levels</td>
</tr>
</tbody>
</table>
Frequency Subsystem

:FRQuency

: CW?

RF

LF

RF

:RF

:LF

:RF

: SCALE?

: SCALE?
Amplitude Subsystem

Trigger Subsystem

LF Output Subsystem
Sweep Subsystem
AM Subsystem

- **STATe?**
  - **STATe**
    - **sp** → **value** → **ON|OFF|1|0**

- **DEPTh?**
  - **DEPTh**
    - **sp** → **value**

- **RATe?**
  - **RATe**
    - **sp** → **value** → **sp** → **unit**

- **SOURce?**
  - **SOURce**
    - **sp** → **INT|EXT|INT+EXT**

- **EXTCoupling?**
  - **EXTCoupling**
    - **sp** → **AC|DC**
FM Subsystem

:FM

STATe?

STATe sp ON|OFF|1|0

DEViation?

DEViation sp value

RATE?

RATE sp value sp unit

SOURce?

SOURce sp INT|EXT|INT+EXT

EXTCoupling?

EXTCoupling sp AC|DC
Phase Modulation Subsystem

```
:PM

STATe?
  STATe sp ON|OFF|1|0

DEViation?
  DEViation sp value

RATE?
  RATE sp value sp unit

EXTCoupling?
  EXTCoupling sp AC|DC
```

Pulse Modulation Subsystem

```
:PULM

STATe?
  STATe sp ON|OFF|1|0

SOURce?
  SOURce sp INT|EXT

PERiod?
  PERiod sp value unit

WIDTh?
  WIDTh sp value unit
```
I/Q Modulation Subsystem

Modulation State Subsystem

RF Output State Subsystem
Utility Subsystem

- :SYSTem
- DISPlay?
  - DISPlay  sp  WHITE|BLUE|GREEN
- SSAVer?
  - SSAVer  sp  ON|OFF|1|0
- ERRor?
- DATE?
  - DATE  sp  YYYYMMDD
- TIME?
  - TIME  sp  HHMM
- REFerence?
  - REFerence  sp  INT10MHZ|EXT2MHZ|EXT5MHZ|EXT10MHZ
- PNMD?
  - PNMD  sp  NORMAL|RESFM
Programming Examples

The programming examples in this section keep to the following 3 conventions:

- The programming examples were written for use on an IBM compatible PC.
- The programming examples use USB interface
- The programming examples are written in C programming language and SCPI programming commands, using Agilent VISA transition library (Agilent VTL).

The Agilent VTL is installed when you installed the Agilent IO libraries suite.

The Agilent IO libraries suite contains the latest Agilent VTL and is available at:

http://www.agilent.com/find/iolib

NOTE

Agilent Technology provides programming examples for illustration only. All sample programs assume that you are familiar with the programming language being demonstrated and the tools used to create and debug procedures.

You have a royalty-free right to use, modify, reproduce and distribute the sample application files in any way you find useful, provided that you agree that Agilent has no warranty, obligations, or liability for any sample application files.
Programming in C using the VTL

This section includes basic information about programming in the C language using Agilent VISA transition library (VTL). Note that some of this information may not be relevant to your particular application. For example, if you are not using VXI instruments, the VXI references will not be relevant.

Typical Example Program Contents

The following table summaries the VTL function calls used in the example programs.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>visa.h</td>
<td>This file is included at the beginning of the each file to provide the function prototypes and constants defined by VTL. For C and C++ programs, you must include the visa.h header file at the beginning of every file that contains VISA function calls: #include &quot;visa.h&quot;</td>
</tr>
<tr>
<td>ViSession</td>
<td>The ViSession is a VTL data type. Each object that will establish a communication channel must be defined as ViSession. Sessions must firstly be opened on the default resource manager, and then for each resource you will be using.</td>
</tr>
<tr>
<td>viOpenDefaultRM</td>
<td>You must first open a session with the default resource manager with the viOpenDefaultRM function, and then for each resource you will be using. This function will initialize the default resource manager and return a pointer to that resource manager session. viOpenDefaultRM(&amp;sesn)</td>
</tr>
</tbody>
</table>
viOpen
This function establishes a communication channel with the device specified. A session identifier that can be used with other VTL functions is returned. This call must be made for each device you will be using.
viOpenDefaultRM(&sesn)
viOpen(sesn, rsrcName, accessMode, timeout, &vi)

viWrite
This function synchronously sends the data pointed to by buf to the device specified by vi. Only one synchronous write operation can occur at any one time.
viWrite(vi, buf, count, &retCount)

viRead
This function synchronously reads raw data from the session specified by the vi parameter and stores the result in location where buf is pointing. Only one synchronous read operation can occur at any one time.
viRead(vi, buf, count, &retCount)

viClose
This function must be used to close each session. When you close a device session, all data structures that had been allocated for the session will be set free. If you close the default resource manager session, all sessions opened using that resource manager session will be closed.
viClose(vi);
viClose(defaultRM)
Example 1 - Checking USB Connection

Usually, using "*IDN?" verifies the data transferring between the controller PC and the instrument.

```c
#include "visa.h"
#include <studio.h>

#define BufferSize 128

static Vistatus status;
static ViSession defaultRM;
static ViSession inst_N9310A;
static ViUInt32 rcount;
static unsigned char buffer[BufferSize];

int main(void)
{
    /* Connect N9310A and read its "IDN". */
    status = viOpen (defaultRM,
                    "USB0::2391::8216::0115000001::0::INSTR", VI_NULL,
                    VI_NULL, &inst_N9310A);
    if (STATUS != VI_SUCCESS); return -1; //failed to connect N9310A
    /* Read "IDN" from N9310A" */
    status = viWrite (inst_N9310A, "*RST\n",
                      StringLength("*RST\n"), &rcount);
    status = viWrite (inst_N9310A, "*IDN?\n",
                      StringLength("*IDN?\n"), &rcount);
    status = viRead (inst_N9310A, buffer, BufferSize,
                     &rcount);
    /* Close connection to N9310A. */
    status = viClose (inst_N9310A);
    status = viClose (defaultRM); return 1;
}
```
### Programming Comments

<table>
<thead>
<tr>
<th>Thread</th>
<th>Relevant code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include the visa.h header file at the beginning of every file that contains VTL function calls.</td>
<td>#include “visa.h”</td>
</tr>
</tbody>
</table>
| Open a session on the default resource manager first, and then for the device you will be using. | viOpenDefaultRM (&defaultRM)  
viOpen (defaultRM, “USB0::2391::8216::0115000001::0::INSTR”, VI_NULL, VI_NULL, &inst_N9310A) |
| Send a *RST command to set the instrument to its default status. | viWrite (inst_N9310A, "*RST\n", StringLength ("*RST\n"), &rcount) |
| Send a *IDN? query to the instrument. | viWrite (inst_N9310A, "*IDN?\n", StringLength ("*IDN?\n"), &rcount) |
| Fetch the instrument identity information to the buffer. | viRead (inst_N9310A, buffer, BufferSize, &rcount) |
| Close device session | viClose (inst_N9310A)  
viClose (defaultRM) |
Example 2 - Generating a CW signal

Assume you wish to generate a CW signal with a frequency of 1 GHz and an amplitude of –10 dBm.

```c
int main(void)
{
    status = viOpenDefaultRM (&defaultRM);
    if (status != VI_SUCCESS) return -1;

    status = viOpen (defaultRM,
                    "USB0::2391::8216::0115000001::0::INSTR", VI_NULL,
                    VI_NULL, &INST_N9310A);
    if (status != VI_SUCCESS) return -1;

    /* Setup N9310A to generate a CW wave. */
    status = viWrite (inst_N9310A, "*RST\n",
                      StringLength("*RST\n"), &rcount);
    status = viWrite (inst_N9310A, "FREQ:CW 1 GHz\n",
                      StringLength("FREQ:CW 1 GHz\n"), &rcount);
    status = viWrite (inst_N9310A, "AMPL:CW -10 dBm\n",
                      StringLength("AMPL:CW -10 dBm\n"), &rcount);
    status = viWrite (inst_N9310A, "RFO:STAT ON\n",
                      StringLength("RFO:STAT ON\n"), &rcount);
    status = viClose (inst_N9310A);
    status = viClose (defaultRM)
    return 1;
}
```
**Programming Comments**

<table>
<thead>
<tr>
<th>Thread</th>
<th>Relevant code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a session on the default resource manager first, and then for the device you will be using.</td>
<td><code>viOpenDefaultRM (&amp;defaultRM)</code> &lt;br&gt;<code>viOpen (defaultRM, &quot;USB0::2391::8216::0115000001::0::INSTR&quot;, VI_NULL, VI_NULL, &amp;inst_N9310A)</code></td>
</tr>
<tr>
<td>Preset the signal generator</td>
<td><code>viWrite (inst_N9310A, &quot;*RST\n&quot;, StringLength(&quot;*RST\n&quot;), &amp;rcount)</code></td>
</tr>
<tr>
<td>Set the frequency and amplitude of the CW signal</td>
<td><code>status = viWrite (inst_N9310A, &quot;FREQ:CW 1 GHz\n&quot;, StringLength(&quot;FREQ:CW 1 GHz\n&quot;), &amp;rcount);</code>&lt;br&gt;<code>status = viWrite (inst_N9310A, &quot;AMPL:CW -10 dBm\n&quot;, StringLength(&quot;AMPL:CW -10 dBm\n&quot;), &amp;rcount);</code></td>
</tr>
<tr>
<td>Enable the RF output</td>
<td><code>viWrite (inst_N9310A, &quot;RFO:STAT ON\n&quot;, StringLength(&quot;RFO:STAT ON\n&quot;), &amp;rcount);</code></td>
</tr>
<tr>
<td>Close device session</td>
<td><code>viClose (inst_N9310A)</code> &lt;br&gt;<code>viClose (defaultRM)</code></td>
</tr>
</tbody>
</table>
Example 3 - Generating an AM Signal

Assume you wish to generate an AM signal, with the following characters:

- AM depth = 80%
- AM rate = 10 kHz
- AM source = internal source
- CW. frequency = 1 GHz
- CW. amplitude = –10 dBm

******************************************************************************

/* Setup N9310A to generate an AM wave. */
int main(void)
{
    status = viOpenDefaultRM (&defaultRM);
    if (status != VI_SUCCESS) return -1;
    status = viOpen (defaultRM,
        "USB0::2391::8216::011500001::0::INSTR", VI_NULL,
        VI_NULL, &INST_N9310A);
    if (status != VI_SUCCESS) return -1;
    /* Configure the carrier. */
    status = viWrite (inst_N9310A, "*RST\n",
        StringLength("*RST\n"), &rcount);
    status = viWrite (inst_N9310A, "FREQ:CW 1 GHz\n",
        StringLength("FREQ:CW 1 GHz\n"), &rcount);
    status = viWrite (inst_N9310A, "AMPL:CW –10 dBm\n",
        StringLength("AMPL:CW –10 dBm\n"), &rcount);
    /* Configure the AM. */
    status = viWrite (inst_N9310A, "AM:DEPT 80\n",
        StringLength("AM:DEPT 80\n"), &rcount);
    status = viWrite (inst_N9310A, "AM:RATE 10 kHz\n",
        StringLength("AM:RATE 10 kHz\n"), &rcount);
    /* Enable AM and RF output. */
    status = viWrite (inst_N9310A, "AM:STAT ON\n",
        StringLength("AM:STAT ON\n"), &rcount);
status = viWrite (inst_N9310A, "RFO:STAT ON\n", 
StringLength("RFO:STAT:ON\n", &rcount);

/* Close session. */
status = viClose (inst_N9310A);
status = viClose (defaultRM)
return 1;
}

### Programming Comments

<table>
<thead>
<tr>
<th>Thread</th>
<th>Relevant code</th>
</tr>
</thead>
</table>
| **Open a session on the default resource manager first, and then for the device you will be using.** | viOpenDefaultRM (&defaultRM) 
viOpen (defaultRM, "USB0::2391::8216::011500001::0::INSTR", VI_NULL, VI_NULL, &inst_N9310A) |
| **Preset the signal generator** | viWrite (inst_N9310A, "*RST\n", StringLength("*RST\n"), &rcount) |
| **Set the frequency and amplitude of the CW signal** | viWrite (inst_N9310A, "FREQ:CW 1 GHz\n", StringLength("FREQ:CW 1 GHz\n"), &rcount) 
viWrite (inst_N9310A, "AMPL:CW –10 dBm\n", StringLength("AMPL:CW –10 dBm\n"), &rcount) |
| **Set AM depth and AM rate** | viWrite (inst_N9310A, "AM:DEPT 80\n", StringLength("AM:DEPT 80\n"), &rcount) 
viWrite (inst_N9310A, "AM:RATE 10 kHz\n", StringLength("AM:RATE 10 kHz\n"), &rcount) |
| **Enable AM** | viWrite (inst_N9310A, "AM:STAT ON\n", StringLength("AM:STAT:ON\n"), &rcount) |
| **Enable the RF output** | viWrite (inst_N9310A, "RFO:STAT ON\n", StringLength("RFO:STAT:ON\n"), &rcount) |
| **Close device session** | viClose (inst_N9310A) 
viClose (defaultRM) |

**NOTE**

After presetting the signal generator, the AM source is set to internal source and the modulation state is set to On by default. The commands to set the AM source and the Modulation state are omitted in this example.
Example 4 - Generating an continuous RF Sweep

Assume you wish to initiate an RF sweep, with the following characters:

- RF sweeps from 1 GHz to 2 GHz
- Sweeps across 90 points linearly
- Dwells for 20 ms for each point
- Repeats sweep continuously
- Triggers immediately and continuously over all points

******************************************************************************
/* Setup N9310A to generate an continuous RF output. */
int main(void)
{
    status = viOpenDefaultRM (&defaultRM);
    if (status != VI_SUCCESS) return -1;
    status = viOpen (defaultRM,
        “USB0::2391::8216::011500001::0::INSTR”, VI_NULL,
        VI_NULL, &INST_N9310A);
    if (status != VI_SUCCESS) return -1;
    /* Configure an RF sweep. */
    status = viWrite (inst_N9310A, “*RST\n”,
        StringLength(“*RST\n”), &rcount);
    status = viWrite (inst_N9310A, “SWE:RF:STAR 1 GHz\n”, StringLength(“SWE:RF:STAR 1 GHz\n”), &rcount);
    status = viWrite (inst_N9310A, “SWE:RF:STOP 2 GHz\n”, StringLength(“SWE:RF:STOP 2 GHz\n”), &rcount);
    status = viWrite (inst_N9310A, “SWE:STEP:POIN 90\n”, StringLength(“SWE:STEP:POIN 90\n”), &rcount);
    status = viWrite (inst_N9310A, “SWE:STEP:DWEL 20 ms\n”, StringLength(“SWE:STEP:DWEL 20 ms\n”), &rcount);
    /* Enable RF sweep & initiate the RF sweep. */
    status = viWrite (inst_N9310A, “RFO:STAT ON\n”,
        StringLength(“RFO:STAT ON\n”), &rcount);
status = viWrite (inst_N9310A, “SWE:RF:STAT ON\n”, StringLength(“SWE:RF:STAT ON\n”), &rcount);
/* Close session. */
status = viClose (inst_N9310A);
status = viClose (defaultRM);
return 1;
}

### Programming Comments

<table>
<thead>
<tr>
<th>Thread</th>
<th>Relevant code</th>
</tr>
</thead>
</table>
| Open a session on the default resource manager first, and then for the device you will be using. | viOpenDefaultRM (&defaultRM)
viOpen (defaultRM, “USB0::2391::8216::011500001::0::INSTR”, VI_NULL, VI_NULL, &inst_N9310A) |
| Preset the signal generator                 | viWrite (inst_N9310A, “*RST\n”, StringLength("*RST\n"), &rcount)             |
| Set the start frequency and the stop frequency | viWrite (inst_N9310A, “SWE:RF:STAR 1 GHz\n”, StringLength("SWE:RF:STAR 1 GHz\n"), &rcount)  |
|                                           | viWrite (inst_N9310A, “SWE:RF:STOP 2 GHz\n”, StringLength("SWE:RF:STOP 2 GHz\n"), &rcount) |
| Set the number of points and dwell time for each point | viWrite (inst_N9310A, “SWE:STEP:POIN 90\n”, StringLength("SWE:STEP:POIN 90\n"), &rcount)  |
|                                           | viWrite (inst_N9310A, “SWE:STEP:DWEL 20 ms\n”, StringLength("SWE:STEP:DWEL 20 ms\n"), &rcount) |
| Enable RF output                            | viWrite (inst_N9310A, “RFO:STAT ON\n”, StringLength("RFO:STAT ON\n"), &rcount) |
| Enable RF sweep                             | viWrite (inst_N9310A, “SWE:RF:STAT ON\n”, StringLength("SWE:RF:STAT ON\n"), &rcount) |
| Close device session                        | viClose (inst_N9310A)                                                         |
|                                             | viClose (defaultRM)                                                           |

**NOTE**

After presetting the signal generator, the Sweep Repeat is set to CONT, Sweep Direction is set to UP and Sweep trigger and Point trigger is set to IMMEDIATE by default. The commands to set the Sweep Repeat, Sweep Direction, Sweep trigger and Point trigger are omitted in this example.
6 Subsystem Command Reference
7 Instrument Messages

Overview 174
Command Errors 175
Execution Conflict 178
System Errors 179
Hardware Errors 180
Overview

The instrument messages include system messages and error messages.

System messages

If an improper operation occurs during the instrument configuration, a system message displays in the text area of the screen, indicating the incident and the how the signal generator corrected the setting automatically. The system messages will be cleared automatically after a period of 30 seconds.

Error messages

If a system error or a hardware error occurs, the error messages will appear on the screen and an ERR annunciator displays also on the screen. Then you need to press > Error Info to read the specific descriptions of those error messages.

Example

In this example, an explanation is generally included with each error to further clarify its meaning. The instrument messages in this guide are listed numerically.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-222</td>
<td>Data out of range; Value clipped to lower limit.</td>
</tr>
</tbody>
</table>

Indicates that the user has entered a deviation, depth or internal source frequency that is beyond the specified limits.

<Explanation in manual>
Command Errors

The messages listed below are command errors, which are saved into local registers. Press \> Error Info to read or delete them.

-100 Command error;
An unrecognized command or data type was encountered. This message is used when the device cannot detect more specifics described for errors -101 to -109.

-101 Invalid character;
A syntactic element contains an invalid character.

-102 Syntax error;
An unrecognized command or data type was encountered.

-103 Invalid separator;
The parser recognized a separator that is not allowed.

-108 Parameter not allowed;
More parameters were received than expected for the header.

-109 Missing parameter;
Fewer parameters were received than required for the header.

-110 Command header error;
An error was detected in the header. This message is used when the device cannot detect more specifics described for errors -111 to -119.
7 Instrument Messages

-111 Header separator error;
A character that is not a legal header separator was encountered while parsing the header.

-112 Program mnemonic too long;
The header contains more than 12 characters.

-113 Undefined header;
The header is correct in syntax, but it is undefined for this device.

-120 Numeric data error;
An error occurred when parsing a data element that appears to be numeric including non-decimal numeric types. Specific details are not available.

-121 Invalid character in numeric;
An invalid character for the data type being parsed was encountered.

-124 Too many digits;
The mantissa of a decimal-numeric data element contained more than 20 digits excluding leading zeros.

-128 Numeric data not allowed;
A legal numeric data element was received, but the device does not accept one in this position for the header.

-130 Suffix error;
This error is generated when parsing a suffix. This message is used when the device cannot detect more specifics described for errors -101 to -109.
-131 Invalid suffix;
The suffix does not follow the syntax described in IEEE 488.2, or the suffix is inappropriate for the device.

-134 Suffix too long;
The suffix contained more than 12 characters.

-138 Suffix not allowed;
A suffix was encountered after a numeric element which does not allow suffixes.

-140 Character data error;
This error is generated when parsing a character data element. This particular error message should be used if the device cannot detect a more specific error.

-141 Invalid character data;
Either the character data element contains an invalid character or the particular element received is not valid for the header.

-144 Character data too long;
The character data element contains more than twelve characters.

-148 Character data not allowed;
A legal character data element was encountered where prohibited by the device.
Execution Conflict

The system messages listed below are execution conflicts, indicating settings conflict during your operation. These messages will be cleared from the screen by the signal generator automatically 30 seconds later since they were generated.

-221 Setting conflict;
start frequency must be smaller than stop frequency.

-221 Setting conflict;
start amplitude must be smaller than stop amplitude.

-221 Setting conflict;
AM cannot be enabled with I/Q or pulse.

-221 Setting conflict;
FM cannot be enabled together with ΦM.

-221 Setting conflict;
LF cannot be enabled together with AM/FM/ΦM/LF sweep.

-221 Setting conflict;
Pulse width must be narrower than pulse period.

-221 Setting conflict;
ΦM deviation range is decided by ΦM rate.

-221 Setting conflict;
AM carrier frequency cannot be lower than 100 kHz.

-221 Setting conflict;
Modulation rate must be lower than carrier frequency.

-222 Value clipped to upper limit.

-222 Value clipped to lower limit.

-255 Media/Directory full.
System Errors

-310  System error;
       write file error.
       An attempt to write to a file has failed.

-310  System error;
       Recall file error.
       Error encountered while loading system files.

-310  System error;
       Error detecting USB peripheral device.
       Error encountered while attempt to detecting USB peripheral device. For example, Set Catalog to USB without USB device inserted.

-310  System error;
       File name exists, can not save current file.
       Current file can not cover the existed file with the same file name.

-313  Calibration memory lost;
       Error locating calibration file.
       An expected file was not found while trying to load internal calibration.
Hardware Errors

501  Mother board +15 V power supply failed.
501  Mother board -15 V power supply failed.
501  Mother board +24 V power supply failed.
501  Mother board +5 V power supply failed.
601  Digital board +5 V power supply failed.
601  Digital board +15 V power supply failed.
601  Digital board -15 V power supply failed.
601  Digital board +5 V power supply failed.
601  Digital board -5 V power supply failed.
601  Digital board +17 V power supply failed.
601  Digital board +8.3 V power supply failed.
601  Digital board +34 V power supply failed.
602  Digital VCO failed.
      Digital 100 M VCO failed.
702  Analog board VCO unlock.
703  Analog board VCO 4 G PLL unlocked.
704  Analog board level error at 4 G-7 G.
705  Analog board level error at 4 G.
706  Analog board level error at 9 k-3 G.
This Chapter contains information on instrument troubleshooting, service, and SCPI commands.
Check the Basics

When having difficulties with the signal generator, check its functionality using the following steps:

- Is there AC power at the power connector?
- Is the signal generator turned on? Listen for internal fan noise to determine if the cooling fan is running. Feel the right side of the signal generator to check for air flow.
- When using other equipment, cables, and connectors with the signal generator, make sure to have them connected properly, and that they are operating correctly.
- Review the operation procedures from when the problem first appeared. Are all the settings correct?
- If the signal generator is not functioning as expected, return the signal generator to a known state by pressing [Preset] hardkey.
- Are measurements and results within the specification and capabilities of the signal generator? Refer to the Technical Overview for your generator.
- Is the signal generator displaying an error message? If so, refer to the Chapter 7, “Instrument Messages”.

**WARNING**

There are no serviceable components in the signal generator. To prevent Electrical shock, please do not disassemble the signal generator. Contact Agilent Technologies or a professional service provider.

**NOTE**

A button cell battery provides power to the real time clock of the signal generator. It is not rechargeable. If the N9310A seems to be encountering a clock defect, contact the nearest Agilent Customer Contact Center (CCC) for service.
Read the warranty

Agilent technologies provides a one year standard warranty. The warranty information for the signal generator is in the back of your *Technical Overview*. Please read it and become familiar with its terms.

If the signal generator is covered by a separate maintenance agreement, please check it and be familiar with its terms.

Agilent Technologies offers several optional maintenance plans to service the signal generator after its warranty has expired. Call the nearest Agilent Technologies sales office for full details.

To provide in house service for the signal generator after the warranty expires, a service guide can be purchased that provides all necessary test and maintenance information.

**NOTE**

The calibration cycle of N9310A RF signal generator is one year.
Contact Agilent Technologies

Agilent Technologies has offices around the world to provide you with complete support for your source. To obtain servicing information or to order replacement parts, contact the Agilent Technologies customer contact center listed below. In any correspondence or telephone conversations, refer to your signal generator by its product number and full serial number.

**Online help:** [http://www.agilent.com/find/assist](http://www.agilent.com/find/assist)

<table>
<thead>
<tr>
<th>United State</th>
<th>Canada</th>
<th>Europe</th>
</tr>
</thead>
<tbody>
<tr>
<td>(tel) 800 829 4444</td>
<td>(tel) 877 894 4414</td>
<td>(tel) +31 20 547 2111</td>
</tr>
<tr>
<td>(fax) 800 829 4433</td>
<td>(fax) 800 746 4866</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Korea</th>
<th>Japan</th>
<th>Latin America</th>
</tr>
</thead>
<tbody>
<tr>
<td>(tel) 080 769 0800</td>
<td>(tel) 0120 802 363</td>
<td>(tel) +1 (305) 269 7500</td>
</tr>
<tr>
<td>(fax) 080 769 0900</td>
<td>(fax) 0120 660 524</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>China</th>
<th>Taiwan</th>
<th>Australia</th>
</tr>
</thead>
<tbody>
<tr>
<td>(tel) 800 810 0189</td>
<td>(tel) 0800 047 866</td>
<td>(tel) 1 800 629 485</td>
</tr>
<tr>
<td>(fax) 800 820 2816</td>
<td>(fax) 0800 286 331</td>
<td>(fax) +61 (3) 9210 5947</td>
</tr>
</tbody>
</table>

**Other Pacific Countries**

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(tel) +65 6375 8100</td>
</tr>
<tr>
<td>(fax) +65 6755 0042</td>
</tr>
</tbody>
</table>

E-mail: tm_ap@agilent.com
## List of Commands

<table>
<thead>
<tr>
<th>SCPI Command</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>:FREQuency:CW &lt;val&gt; &lt;unit&gt;</td>
<td>page 109</td>
</tr>
<tr>
<td>:FREQuency:CW?</td>
<td></td>
</tr>
<tr>
<td>:FREQuency:RF:START &lt;val&gt; &lt;unit&gt;</td>
<td>page 110</td>
</tr>
<tr>
<td>:FREQuency:RF:START?</td>
<td></td>
</tr>
<tr>
<td>:FREQuency:RF:STOP &lt;val&gt; &lt;unit&gt;</td>
<td>page 110</td>
</tr>
<tr>
<td>:FREQuency:RF:STOP?</td>
<td></td>
</tr>
<tr>
<td>:FREQuency:LF:START &lt;val&gt; &lt;unit&gt;</td>
<td>page 111</td>
</tr>
<tr>
<td>:FREQuency:LF:START?</td>
<td></td>
</tr>
<tr>
<td>:FREQuency:LF:STOP &lt;val&gt; &lt;unit&gt;</td>
<td>page 111</td>
</tr>
<tr>
<td>:FREQuency:LF:STOP?</td>
<td></td>
</tr>
<tr>
<td>:FREQuency:RF:SCALE LOG</td>
<td>LIN</td>
</tr>
<tr>
<td>:FREQuency:RF:SCALE?</td>
<td></td>
</tr>
<tr>
<td>:AMPLitude:CW &lt;val&gt; &lt;unit&gt;</td>
<td>page 113</td>
</tr>
<tr>
<td>:AMPLitude:CW?</td>
<td></td>
</tr>
<tr>
<td>:AMPLitude:STARt &lt;val&gt; &lt;unit&gt;</td>
<td>page 114</td>
</tr>
<tr>
<td>:AMPLitude:STARt?</td>
<td></td>
</tr>
<tr>
<td>:AMPLitude:STOP &lt;val&gt; &lt;unit&gt;</td>
<td>page 114</td>
</tr>
<tr>
<td>:AMPLitude:STOP?</td>
<td></td>
</tr>
<tr>
<td>:TRIGger:IMMediate</td>
<td>page 115</td>
</tr>
<tr>
<td>:TRIGger:SSWP</td>
<td>page 115</td>
</tr>
<tr>
<td>:SWEep:RF:STATE ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:SWEep:RF:STATE?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:LF:STATE ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:SWEep:LF:STATE?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:AMPLitude:STATE ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:SWEep:AMPLitude:STATE?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:RF:START &lt;val&gt; &lt;unit&gt;</td>
<td>page 119</td>
</tr>
<tr>
<td>:SWEep:RF:START?</td>
<td></td>
</tr>
</tbody>
</table>
### SCPI Command Page 8

<table>
<thead>
<tr>
<th>Command</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>:SWEep:LF:STARt &lt;val&gt; &lt;unit&gt;</td>
<td>page 120</td>
</tr>
<tr>
<td>:SWEep:LF:STARt?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:RF:STOP &lt;val&gt; &lt;unit&gt;</td>
<td>page 119</td>
</tr>
<tr>
<td>:SWEep:RF:STOP?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:LF:STOP &lt;val&gt; &lt;unit&gt;</td>
<td>page 120</td>
</tr>
<tr>
<td>:SWEep:LF:STOP?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:AMPLitude:STARt &lt;val&gt; &lt;unit&gt;</td>
<td>page 121</td>
</tr>
<tr>
<td>:SWEep:AMPLitude:STARt?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:AMPLitude:STOP &lt;val&gt; &lt;unit&gt;</td>
<td>page 121</td>
</tr>
<tr>
<td>:SWEep:AMPLitude:STOP?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:STEP:POINts &lt;val&gt;</td>
<td>page 122</td>
</tr>
<tr>
<td>:SWEep:STEP:POINts?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:STEP:DWELL &lt;val&gt; &lt;unit&gt;</td>
<td>page 122</td>
</tr>
<tr>
<td>:SWEep:STEP:DWELL?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:REPeat SINGle</td>
<td>CONTinuous</td>
</tr>
<tr>
<td>:SWEep:REPeat?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:STRG IMMmediate</td>
<td>EXT</td>
</tr>
<tr>
<td>:SWEep:STRG?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:STRG:SLOPe EXTN</td>
<td>EXTP</td>
</tr>
<tr>
<td>:SWEep:STRG:SLOPe?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:PTRG IMMmediate</td>
<td>EXT</td>
</tr>
<tr>
<td>:SWEep:PTRG?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:PTRG:SLOPe EXTN</td>
<td>EXTP</td>
</tr>
<tr>
<td>:SWEep:PTRG:SLOPe?</td>
<td></td>
</tr>
<tr>
<td>:SWEep:DIRection UP</td>
<td>DOWN</td>
</tr>
<tr>
<td>:SWEep:DIRection?</td>
<td></td>
</tr>
<tr>
<td>:AM:STATe ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:AM:STATe?</td>
<td></td>
</tr>
<tr>
<td>:AM:DEPTh &lt;val&gt;</td>
<td>page 133</td>
</tr>
<tr>
<td>:AM:DEPTh?</td>
<td></td>
</tr>
<tr>
<td>SCPI Command</td>
<td>Page #</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>:AM:RATE &lt;val&gt; &lt;unit&gt;</td>
<td>page 133</td>
</tr>
<tr>
<td>:AM:RATE?</td>
<td></td>
</tr>
<tr>
<td>:AM:SOURce INT</td>
<td>EXT</td>
</tr>
<tr>
<td>:AM:SOURce?</td>
<td></td>
</tr>
<tr>
<td>:AM:EXTCoupling AC</td>
<td>DC</td>
</tr>
<tr>
<td>:AM:EXTCoupling?</td>
<td></td>
</tr>
<tr>
<td>:FM:STATE ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:FM:STATE?</td>
<td></td>
</tr>
<tr>
<td>:FM:DEViation &lt;val&gt; &lt;unit&gt;</td>
<td>page 136</td>
</tr>
<tr>
<td>:FM:DEViation?</td>
<td></td>
</tr>
<tr>
<td>:FM:RATE &lt;val&gt; &lt;unit&gt;</td>
<td>page 136</td>
</tr>
<tr>
<td>:FM:RATE?</td>
<td></td>
</tr>
<tr>
<td>:FM:SOURce INT</td>
<td>EXT</td>
</tr>
<tr>
<td>:FM:SOURce?</td>
<td></td>
</tr>
<tr>
<td>:FM:EXTCoupling AC</td>
<td>DC</td>
</tr>
<tr>
<td>:FM:EXTCoupling?</td>
<td></td>
</tr>
<tr>
<td>:PM:STATE ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:PM:STATE?</td>
<td></td>
</tr>
<tr>
<td>:PM:DEViation &lt;val&gt; &lt;unit&gt;</td>
<td>page 139</td>
</tr>
<tr>
<td>:PM:DEViation?</td>
<td></td>
</tr>
<tr>
<td>:PM:RATE &lt;val&gt; &lt;unit&gt;</td>
<td>page 139</td>
</tr>
<tr>
<td>:PM:RATE?</td>
<td></td>
</tr>
<tr>
<td>:PULM:STATE ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:PULM:STATE?</td>
<td></td>
</tr>
<tr>
<td>:PULM:SOURce INT</td>
<td>EXT</td>
</tr>
<tr>
<td>:PULM:SOURce?</td>
<td></td>
</tr>
<tr>
<td>:PULM:PERiod &lt;val&gt; &lt;unit&gt;</td>
<td>page 141</td>
</tr>
<tr>
<td>:PULM:PERiod?</td>
<td></td>
</tr>
<tr>
<td>:PULM:WIDTH &lt;val&gt; &lt;unit&gt;</td>
<td>page 141</td>
</tr>
<tr>
<td>:PULM:WIDTH?</td>
<td></td>
</tr>
<tr>
<td>SCPI Command</td>
<td>Page #</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>:IQ:STATe ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:IQ:STATe?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:DISPlay WHITE</td>
<td>BLUE</td>
</tr>
<tr>
<td>:SYSTem:DISPlay?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:ERRor?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:SSAVer ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:SYSTem:SSAVer?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:DATE &lt;year&gt;&lt;month&gt;&lt;day&gt;</td>
<td>page 144</td>
</tr>
<tr>
<td>:SYSTem:DATE?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:TIME &lt;hour&gt;&lt;minute&gt;</td>
<td>page 145</td>
</tr>
<tr>
<td>:SYSTem:TIME?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:REFERence:FREQuency INT10MHz</td>
<td>EXT2MHz</td>
</tr>
<tr>
<td>:SYSTem:REFERence:FREQuency?</td>
<td></td>
</tr>
<tr>
<td>:SYSTem:PNMD NORMal</td>
<td>RESFM</td>
</tr>
<tr>
<td>:MOD:STATe ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:MOD:STATe?</td>
<td></td>
</tr>
<tr>
<td>:RFOutput:STATe ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:RFOutput:STATe?</td>
<td></td>
</tr>
<tr>
<td>:LFOutput:STATe ON</td>
<td>OFF</td>
</tr>
<tr>
<td>:LFOutput:STATe?</td>
<td></td>
</tr>
<tr>
<td>:LFOutput:FREQuency &lt;val&gt; &lt;unit&gt;</td>
<td>page 150</td>
</tr>
<tr>
<td>:LFOutput:FREQuency?</td>
<td></td>
</tr>
<tr>
<td>:LFOutput:AMPLitude &lt;val&gt; &lt;unit&gt;</td>
<td>page 150</td>
</tr>
<tr>
<td>:LFOutput:AMPLitude?</td>
<td></td>
</tr>
</tbody>
</table>
# Index

## Numerics

<table>
<thead>
<tr>
<th>Numerics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>001, option</td>
<td>3</td>
</tr>
<tr>
<td>1CM, option</td>
<td>3</td>
</tr>
<tr>
<td>1TC, option</td>
<td>3</td>
</tr>
</tbody>
</table>

## A

| AC power cord connection  | 19   |
| localisation              | 20   |
| Agilent Technologies      | 184  |
| AM                         | 54   |
| annunciator                | 7    |
| depth                      | 55   |
| example                    | 43   |
| generate                   | 43   |
| on/off                     | 54   |
| rate                       | 55   |
| source                     | 55   |
| Amplitude area             | 7    |
| Amplitude hardkey          | 4    |
| annunciators               | 7    |
| ARMED annunciator          | 7    |
| arrow keys                 | 5    |
| 58                         |      |

## B

| backspace                  | 66   |
|                           |      |

## C

| CE mark                    | 11   |
|                           |      |

## D

| check the shipment         | 14   |
| connector, maintenance     | 28   |
| connectors                 |      |
| I IN                       | 10   |
| LF Out                     | 6    |
| MOD IN                     | 10   |
| PULSE MOD IN               | 10   |
| Q IN                       | 10   |
| REF IN                     | 10   |
| REF OUT                    | 9    |
| RF Out                     | 6    |
| TRIG IN                    | 9    |
| USB device                 | 10   |
| USB Host                   | 9    |
| VGA                        | 10   |
| continuous wave            | 31   |
| CSA mark                   | 11   |
| c-tick mark                | 11   |

## E

| enable option              | 25   |
| Enter hardkey              | 4    |
| ERR annunciator            | 7    |
| Error message              | 24   |
| error message area         | 8    |
| ESD                        | 21   |
| external trigger source    | 34   |

## F

| factory default settings   | 70   |
| file                       | 59   |
| catalog                    | 59   |
| delete                     | 60   |
| recall                     | 60   |
| save                       | 60   |
| file name                  | 51   |
| firmware update            | 27   |
| FM                         | 61   |
| deviation                  | 62   |
| example                    | 44   |
| ext coupling               | 63   |
| generate                   | 44   |
| on/off                     | 61   |
| rate                       | 62   |
| source                     | 62   |
| frequency area             | 7    |
| Frequency hardkey          | 4    |
| 64                         |      |
| front panel overview       | 4    |

## H

| hardkeys                   |      |
|                           |      |
| Preset                     | 70   |
Index

I
I/Q, 64
   annunciator, 8
   example, 48
   generate, 47
instruction manual, 11
instrument state, 50
IO libraries suite, 26
ISM1-A, 11

K
knob, 5

L
LF
   example, 49
   generate, 49
   sweep, 38
LF OUT, 65
   ampl, 65
   freq, 65
LF Out connector, 6

M
MOD IN, 10
Mod On/Off, 5
Mod On/Off hardkey, 66
   modulation, 41
   simultaneous, 42

N
numeric keypad, 6, 66

O
options
   001, 3, 25, 64
   1CM, 3
   1TC, 3

P
Phase
   generate, 45
   phase, 67
   on/off, 67
Phase example, 45
   power on, 22
   power switch, 9
   pulse, 71
   deviation, 67
   example, 46
   generate, 46
   on/off, 71
   period, 72
   rate, 68
   source, 71
   width, 72
   PULSE MOD IN, 10

R
rack mount, 15
   rear panel overview, 9
requirements
   electrical, 19
   environmental, 18
   ventilation, 18
   RF On/Off, 5, 66
   RF OUT connector, 6
   RF sweep, 35

S
safety notice, 17
   save, 50
   local, 50
   USB, 51
   simultaneous modulation, 42
   single sweep
      initiate, 58
   Softkeys, 4
   softkeys, 30
   sweep
      amplitude, 37
      configuration, 32
      generate, 32
      RF, 35
      trigger, 33
      switch, 68, 69
      power, 69
      standby, 6, 69
      symbols, 11

T
text area, 8
   TFT, 2
   TRIG IN, 9
   trigger
      point, 81
      sweep, 81

U
   update, 27
   USB Device Connectors, 6
   USB Device Connectors, 6

V
   ventilation, 18
   VGA connector, 10

W
   warranty, 183
   WEEE, 12
DECLARATION OF CONFORMITY
According to EN ISO/IEC 17050-1:2004

Manufacturer's Name: Agilent Technologies (Chengdu) Co., Ltd.
Manufacturer's Address: No. 116, 1st Street Tuo Xin West
Chengdu Hi-Tech Industrial Development Zone (South),
Chengdu, 610041, China

Declares under sole responsibility that the product as originally delivered

Product Name: RF Signal Generator
Model Number: N9310A
Product Options: This declaration covers all options of the above product(s)

complies with the essential requirements of the following applicable European Directives, and

carries the CE marking accordingly:

Low Voltage Directive 2006/95/EC
EMC Directive 2004/108/EC

and conforms with the following product standards:

<table>
<thead>
<tr>
<th>EMC</th>
<th>Standard</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reference Standards</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CISPR 11:2003 / EN 55011:2007</td>
<td>Class A Group 1</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-2:2001 / EN 61000-4-2</td>
<td>4 kV/4 kV contact/air</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-3:2002 / EN 61000-4-3</td>
<td>3 V/m, 80-2000 MHz, 1 V/m, 2-2.7 GHz</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-4:2004 / EN 61000-4-4</td>
<td>0.5 kV signal lines, 1 kV power lines</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-5:2001 / EN 61000-4-5</td>
<td>0.5 kV line-line, 1 kV line-ground</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-6:2003 / EN 61000-4-6</td>
<td>3 V, 0.15-80 MHz</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-11:2004 / EN 61000-4-11</td>
<td>1 cycle, &gt;95%</td>
</tr>
</tbody>
</table>

Canada: ICES/NMB-001:2006
Australia/New Zealand: AS/NZS CISPR 11:2004

The product was tested in a typical configuration with Agilent Technologies test systems.

Safety
IEC 61010-1:2001 / EN 61010-1:2001
Canada: CAN/CSA-C22.2 No. 61010-1-04,
USA: ANSI/UL 61010-1:2004,

Supplementary Information:

This DoC applies to above-listed products placed on the EU market after:

Sep 28, 2009
Date

Shi Wen
Quality Manager

For further information, please contact your local Agilent Technologies sales office, agent or distributor,
or Agilent Technologies Deutschland GmbH, Herrenberger Straße 130, D 71034 Böblingen, Germany.

N9310A Rev 3.0